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Introduction
in this document.
Experienced users should head down to this section
Audacity ...
a free cross platform audio editor.
For new users to Audacity, see the Tutorial in five parts for
some basics on digital audio, setting up Audacity, selecting,
aligning, and recording.
Audacity is currently in version 1.2.3. This is a stable
release of Audacity; it has been tested and works well for
most people. However, it comes with no guarantee, and we
depend on your feedback in order to continue to improve on
it. Please check our website for the latest version. Audacity
is a collaborative project, so there are lots of opportunities
for you to get involved if you're interested!
http://audacity.sourceforge.net/
What can you do with Audacity?
Audacity is a program that manipulates digital
audio waveforms. In addition to recording
sounds directly from within the program, it
imports many sound file formats, including
WAV, AIFF, MP3, and Ogg Vorbis. PCM
formats of 8,16,24 and 32−bits can be imported
and exported.
• Cut, Copy, Paste, Delete, Silence,
Duplicate, Split

What can't Audacity do?
Although Audacity is a very powerful audio editor
that works with an unlimited number tracks of
virtually unlimited size, it cannot do everything. It
cannot :
• Audacity cannot record more than two
channels at once on many systems. Some
support for multitrack recording is included
in version 1.2.3, but it does not support very
many systems yet.
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• apply plug−in effects to any part of a
sound
• built−in volume envelope editor
• customizable spectrogram track view
mode
• frequency analysis window for audio
analysis applications
• custom playback rate for every track,
which is live−resampled to the project
sample rate
• simple to complex align operations for
tracks and groups of tracks

• Audacity opens MIDI files, but it is not a
MIDI editor, and its MIDI features are
extremely limited.

How does it work − a quick intro for experienced users
Audacity works with tracks, that contain one
There is volume automation via the envelope
audio file. This file is editable and all actions are tool.
undoable. Undo's are instantaneous.
Editing functions include Cut, Copy,
Almost anything is undoable, including importing Paste,Duplicate(to new track at same timecode),
and deleting tracks!
Split(to new track at same timecode), and
Silence.
There are no inserts, auxes or buses yet.
A grid can be activated for each track, and
All versions can use LADSPA plugins, and the snapping can be switched on as well.
Windows and Mac versions can use VST plugins
using the VST Enabler (a separate download).
What makes Audacity unique?
• Audacity is free and the source code is available under the GNU General Public License.
• Audacity is cross−platform − it runs on Windows (98 through XP), Mac OS X, and many
Unix platforms, including Linux. Previous versions worked with Mac OS 9.
• No limits on the number of tracks or the length of any track, except the size of your hard disk.
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• Import almost anything: WAV, AIFF, Next/AU, IRCAM, MP3, and Ogg Vorbis files are
supported natively, but Audacity will also open just about any uncompressed sound file and
automatically deduce the format (using the Import Raw Data... feature).
• Audacity not only includes many high−quality effects built−in, but also lets you use
LADSPA and VST plug−in effects. There are dozens of free, shareware, and commercial
plug−ins online that do everything from Reverb to Noise Reduction.
• Audacity supports plug−ins written in the Nyquist programming language, a high−level
language designed specifically for working with audio.
• Audacity acts like a non−destructive editor, providing multiple levels of undo, but it also
writes changes made to the audio to disk, eliminating the need for complicated real−time
processing.
• Label tracks allow you to annotate waveforms (for example, transcribing speech) and later
export the waveforms to a text file.
• Powerful spectral features allow you to view waveforms as spectrograms or plot the power
spectrum of any region of audio, and even export this data to a spreadsheet.
• Pitch−changing and tempo−changing effects
Back to the main page
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Credits
The Audacity manual was written by Anthony Oetzmann, with major contributions by Dominic
Mazzoni.
Anthony Oetzmann is the primary documentation writer for Audacity. He wrote most of the manual
you are reading now, and has also influenced the program design significantly. He is a professional
audio engineer who lives and works in Germany.
Dominic Mazzoni is the Audacity project leader and Audacity's primary programmer. He began the
project while a graduate student at Carnegie Mellon University in Pittsburgh, PA. He is currently a
research programmer at the NASA Jet Propulsion Laboratory in Pasadena, CA.
The Audacity logo was designed by Harvey Lubin of Agrapha.
For a list of all of the people who contributed to Audacity, and for up−to−date contact information
for Tony, Dominic, and other contributors, please visit our website at:
http://audacity.sourceforge.net.
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What's New in Audacity 1.2 ??
(History of Audacity)
New features in Audacity 1.2:

User Interface

Effects

• Repeat Last Effect command.
• New Mixer toolbar allows you to
• Support for LADSPA plug−ins on all
control the output volume, input
platforms.
volume, and input source directly
• VST support now comes through an
from Audacity.
optional LADSPA plug−in called the
• Every track now has its own gain
VST Enabler.
and pan controls.
• Most effects now have a Preview
• Uses improved project file format.
button.
• Block files (stored in Audacity
• Compressor (Dynamic Range
project directories) now use the
Compressor).
standard AU format. Though some
• Change Pitch (without changing
Audacity meta−information is in
tempo).
these files, they can now be read by
• Change Tempo (without changing
many other popular audio programs
pitch).
as well.
• Import RAW has a simpler GUI but
• Change Speed (changing both pitch
support for far more file formats.
and tempo).
The autodetection algorithms are
• Repeat (useful for creating loops).
much more accurate than in 1.0.
• Normalize (adjust volume and DC
• Using high quality resampling
bias).
algorithms, with the option of better
quality for mixing than for real−time Audio I/O
playback.
• Preliminary support for Time Tracks,
• 1−second preview command (just hit
for changing playback speed over
the '1' key on your keyboard).
time.
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• Vertical zooming of tracks.
• Improved look and placement of
toolbars.
• New custom mouse cursors.
• Complete implementation of editable
keyboard shortcuts.
• Find zero−crossings.
• Mouse wheel can be used to zoom in
and out.
• Multi−Tool mode.
• Amplify and fade using envelope.
• Labels can store selections (like
Audacity 1.0.0).
• Open multiple files from the same
dialog.
New features in Audacity 1.1.1:

User Interface

• Looped play (Shift−click on the Play
button).

Mac OS X

• Support for more audio hardware
• Tooltips appear in Statusbar.
• Support for full−duplex (play while
• Vertical cursor follows play/record.
recording).
• Pause button.
• Drawing tool (with three different
• Support for MP3 exporting using
modes).
LameLib Carbon.
• Vertical Resizing of stereo tracks is
• Hardware and Software playthrough
more fun.
support.
• Adjust selection by click−dragging
selection boundary.
Unix
• Toolbar button context−sensitive
enabling/disabling.
• Audacity now has a man page (it
• Better zooming functionality (centers
describes command−line options and
region).
how to set the search path).
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• Multiple ways to display the cursor
position and selection.
• Snap−to selection mode.
• Drag tracks up and down.
• Align and group align functions.
• Cursor save/restore.
• Working history window.

Effects

File Formats
• Uses libsndfile, which fixes some
bugs and improves performance.
Allows a wide range of
uncompressed audio formats to be
imported and exported

Searching for Files:

• Effects broken down into three
menus: Generate, Effect, and
Analyze.
• Generate menu lets you generate
silence, noise, or a tone.
• Nyquist support (supports plug−ins
written in Nyquist, an interpreted
functional language based on Lisp).

Localization
• Improved localization support.
• More languages available.
• Language selection dialog on first
startup.
New features in Audacity 1.1.0:
New libraries in Audacity 1.1:

• On Windows and Mac OS, Audacity
now looks for translations in the
"Languages" folder and all plug−ins
in the "Plug−ins" folder, relative to
the program.
• On Unix, Audacity looks for
translations in <prefix>/share/locale
and looks for everything else in
<prefix>/share/audacity and also in
any paths in the AUDACITY_PATH
environment variable.

• libmad for fast MP3 importing.
• libid3tag for editing MP3 file information.
• libsndfile to read and write more audio file formats.
• PortAudio for cross−platform audio playing and
recording.
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Back to the main page
Back to the Welcome page
here you'd normally find links to stuff of the same category as the current page

How to use this manual
In this manual you'll find lots of common screen elements, that you can rely on to navigate this
manual.

TOP LEFT CORNER −>

Back to the main page. Having trouble with this? Take a nap
and try again.

TOP MIDDLE −>

Back to the previous page, in this case probably the main page

BOTTOM MIDDLE −>

Back to the previous page, in this case probably the main page

BOTTOM LEFT
−>
CORNER

Back to the main page

To reiterate, to get back to the main contents page, check the top−left corner of the page.
To return to the page above the current one in the manual, check the top−middle of the page.
Any stuff that fits in to the same category of the current page is usually available as a link just above
the page title and below the link back to the previous page.
That way you can jump around all the tutorial pages that belong together for example.

Keyword search
We don't have one. That's why we have the Index of Terms. If you don't know where else to look,
look here.
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Tutorials

I. Basics
1. Digital Audio
2. Rules of Audacity
3. Setup, Audio Import and Playback
4. Recording with Audacity

III. Common Editing Tasks
1. Quickies
2. Editing Vocal Tracks
3. Cutting up long Tracks

II. Editing for Beginners
1. Introduction to Editing...
2. Cut, Copy & Paste
3. Silence, Duplicate and Split
4. Splitting and Submixes

IV. Effects for Beginners
1. A virtual room with Reverbs

V. Selecting and Aligning
1. Selecting
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Back to the Reference page

How do effects work in Audacity ?
Basic Calculus of Acoustics

Reverb Delay Chorus

Looking for a description of the stuff in the Effects Menu ?
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Back to the Tutorial Page
Digital Audio Rules of Audacity Setup, Audio Import and Playback Recording with Audacity

Tutorial − I.Basics
Part 1 − Digital Audio − Part 1
What is sound?
Sounds are pressure waves of air. If there wasn't any air, we wouldn't be able to hear sounds. There's
no sound in space.
We hear sounds because our ears are sensitive to these pressure waves. Perhaps the easiest type of
sound wave to understand is a short, sudden event like a clap. When you clap your hands, the air that
was between your hands is pushed aside. This increases the air pressure in the space near your hands,
because more air molecules are temporarily compressed into less space. The high pressure pushes the
air molecules outwards in all directions at the speed of sound, which is about 340 meters per second.
When the pressure wave reaches your ear, it pushes on your eardrum slightly, causing you to hear the
clap.

A hand clap is a short event that causes a single pressure wave that quickly dies out. The image
above shows the waveform for a typical hand clap. In the waveform, the horizontal axis represents
time, and the vertical axis is for pressure. The initial high pressure is followed by low pressure, but
the oscillation quickly dies out.
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The other common type of sound wave is a periodic wave. When you ring a bell, after the initial
strike (which is a little like a hand clap), the sound comes from the vibration of the bell. While the
bell is still ringing, it vibrates at a particular frequency, depending on the size and shape of the bell,
and this causes the nearby air to vibrate with the same frequency. This causes pressure waves of air
to travel outwards from the bell, again at the speed of sound. Pressure waves from continuous
vibration look more like this:

How is sound recorded?
A microphone consists of a small membrane that is free to vibrate, along with a mechanism that
translates movements of the membrane into electrical signals. (The exact electrical mechanism varies
depending on the type of microphone.) So acoustical waves are translated into electrical waves by
the microphone. Typically, higher pressure corresponds to higher voltage, and vice versa.
A tape recorder translates the waveform yet again − this time from an electrical signal on a wire, to a
magnetic signal on a tape. When you play a tape, the process gets performed in reverse, with the
magnetic signal transforming into an electrical signal, and the electrical signal causing a speaker to
vibrate, usually using an electromagnet.
How is sound recorded digitally ?
Recording onto a tape is an example of analog recording. Audacity deals with digital recordings −
recordings that have been sampled so that they can be used by a digital computer, like the one you're
using now. Digital recording has a lot of benefits over analog recording. Digital files can be copied
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as many times as you want, with no loss in quality, and they can be burned to an audio CD or shared
via the Internet. Digital audio files can also be edited much more easily than analog tapes.
The main device used in digital recording is a Analog−to−Digital Converter (ADC). The ADC
captures a snapshot of the electric voltage on an audio line and represents it as a digital number that
can be sent to a computer. By capturing the voltage thousands of times per second, you can get a
very good approximation to the original audio signal:

Each dot in the figure above represents one audio sample. There are two factors that determine the
quality of a digital recording:
• Sample rate: The rate at which the samples are captured or played back, measured in Hertz
(Hz), or samples per second. An audio CD has a sample rate of 44,100 Hz, often written as
44 KHz for short. This is also the default sample rate that Audacity uses, because audio CDs
are so prevalent.
• Sample format or sample size: Essentially this is the number of digits in the digital
representation of each sample. Think of the sample rate as the horizontal precision of the
digital waveform, and the sample format as the vertical precision. An audio CD has a
precision of 16 bits, which corresponds to about 5 decimal digits.
Higher sampling rates allow a digital recording to accurately record higher frequencies of sound. The
sampling rate should be at least twice the highest frequency you want to represent. Humans can't
hear frequencies above about 20,000 Hz, so 44,100 Hz was chosen as the rate for audio CDs to just
include all human frequencies. Sample rates of 96 and 192 KHz are starting to become more
common, particularly in DVD−Audio, but many people honestly can't hear the difference.
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Higher sample sizes allow for more dynamic range − louder louds and softer softs. If you are
familiar with the decibel (dB) scale, the dynamic range on an audio CD is theoretically about 90 dB,
but realistically signals that are −24 dB or more in volume are greatly reduced in quality. Audacity
supports two additional sample sizes: 24−bit, which is commonly used in digital recording, and
32−bit float, which has almost infinite dynamic range, and only takes up twice as much storage as
16−bit samples.
Playback of digital audio uses a Digital−to−Analog Converter (DAC). This takes the sample and sets
a certain voltage on the analog outputs to recreate the signal, that the Analog−to−Digital Converter
originally took to create the sample. The DAC does this as faithfully as possible and the first CD
players did only that, which didn't sound good at all. Nowadays DACs use Oversampling to smooth
out the audio signal. The quality of the filters in the DAC also contribute to the quality of the
recreated analog audio signal. The filter is part of a multitude of stages that make up a DAC.
How does audio get digitized on your computer?
Your computer has a soundcard − it could be a separate card, like a SoundBlaster, or it could be
built−in to your computer. Either way, your soundcard comes with an Analog−to−Digital Converter
(ADC) for recording, and a Digital−to−Analog Converter (DAC) for playing audio. Your operating
system (Windows, Mac OS X, Linux, etc.) talks to the sound card to actually handle the recording
and playback, and Audacity talks to your operating system so that you can capture sounds to a file,
edit them, and mix multiple tracks while playing.
Standard file formats for PCM audio
There are two main types of audio files on a computer:
• PCM stands for Pulse Code Modulation. This is just a fancy name for the technique described
above, where each number in the digital audio file represents exactly one sample in the
waveform. Common examples of PCM files are WAV files, AIFF files, and
Sound Designer II files. Audacity supports WAV, AIFF, and many other PCM files.
• The other type is compressed files. Earlier formats used logarithmic encodings to squeeze
more dynamic range out of fewer bits for each sample, like the u−law or a−law encoding in
the Sun AU format. Modern compressed audio files use sophisticated psychoacoustics
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algorithms to represent the essential frequencies of the audio signal in far less space.
Examples include MP3 (MPEG I, layer 3), Ogg Vorbis, and WMA (Windows Media
Audio). Audacity supports MP3 and Ogg Vorbis, but not the proprietary WMA format or the
MPEG4 format (AAC) used by Apple's iTunes.
For details on the audio formats Audacity can import from and export to, please check out the
Fileformats page of this documentation. Please remember that MP3 does not store uncompressed
PCM audio data. When you create an MP3 file, you are deliberately losing some quality in order to
use less disk space.
Next part − Rules of Audacity

Back to the main page
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Tutorial − I.Basics
Part 2 − Rules of Audacity − Part 2
If you'd like to get straight playing an imported file or recording something, you can skip this section
and come back later.
Whenever you work with Audacity, there are some rules you should remember:
1. One clip per track
A clip is simply a piece of audio material. Imported, recorded, split or duplicated from another track,
one track can only carry one piece of audio at a time. You can extend it by pasting material or
inserting silence in to it, or cut a piece away, but it will always be one continuous piece of audio.
2. Audacity always records to a new track
This new track is opened at the bottom. You'll have to zoom out and then resize the track view of the
bottom most track to see what is recorded. You can actually use the window sliders at the bottom and
right to do this after starting to record, but this way no performance will be lost to the windowing
system.
I suggest hitting CTRL+F to get an overview of the entire project as well. This only affects the
horizontal zoom by the way(left−right zoom). There is no way to zoom out vertically without using
the mouse yet.
3. Edit/Duplicate will not create a new audio file
This may not seem a big deal, but it is if you're editing a large live recording.
What Audacity does is reference the original audio material until you actually perform some kind of
edit on it, such as cutting a piece away, or using any effect on it. One thing to remember is the
UNDO function. You can undo/redo stuff as many times as you like, and yes, even after you have
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saved your project.
You may ask what happens if you do, for example, cut away a piece or mark off a 30 minute piece
and split it to a new track. It only writes changed data to disk. Since Audacity works with chunk of
audio data of around one megabyte in size, this happens quite fast. Rest assured that the only big
waiting period might be the importing of large audio files.
To further explain how Audacity works, flip to the next page ...
Next Part − Setup, Audio Import and Playback

Back to the main page
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Tutorial − I.Basics
Part 3 − Setup, Audio Import and Playback − Part 3
1. Create a new project
This is very important!
Audacity writes all the changed and recorded audio to a directory called Projectname_data, which is
located right where you saved the project file itself.

Thus, select

and choose a location and filename for your project.

Please note that when you startup Audacity fresh, only the " Save As..." menu option is available.
To save your project later on, you can also use the keyboard shortcut : CTRL+S
2. Check the Preferences
Again, this is very important!
Press CTRL+P or go to ...

...then check if the right output is selected :
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...set the sample rate of your choice... (44.1
kHz is the default)

...and here's a crucial screen :

The File Formats settings need discussing at this point.
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When importing uncompressed audio, there are two ways to do it. "Make a copy of the original
before editing" means, that Audacity actually copies the entire audio file that you imported in to its
project data directory and in the process sets up the little overview graphics, whose descriptions get
stored in the project data directory too.
The second way is to use the original imported audio. You may think we're actually editing this file,
but no we aren't. In fact, Audacity will now read the imported file once and simply create the
graphics overviews for them in the data directory, and subsequently write to disk all the audio data
that you change. The original file is only used for playback. All audio that remains unchanged will
be played from the original file.
The advantage of choosing to make a copy of the original is that you avoid trouble, should
anything in the original file change.
For example, should you accidentally delete the original file, you're lost.
You have to make up your mind before you start a project. Choose to make a copy of all imported
files, and you'll use more space on your hard disk(s), but it will be easier to back up the project too,
because all files that have anything to do with your project will be in the project data directory.
The Uncompressed Export Format can be set to WAV or AIFF for now. Please check the fileformats
page for further information on export formats.
We'll ignore the Spectrogram settings for now. The Directories setting can be ignored as well for
now, because all it sets is the directory to use for recordings, undo data and other stuff, if you haven't
yet saved your project. Since we already saved our project, this setting is of no importance to us,
though you may want to set it properly later on. Initially this is set to a folder called
"audacity_temp_1.2" in the system temporary directory.
3. Import an audio file
There are three ways to do this:
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1. Simply drag and drop the audio file in to the Audacity window. (If you're using Mac OS 9 or X,
drag the audio file to the Audacity icon instead...)
2. Select Import Audio ... in the Project menu.
3. Use the keyboard shortcut : CTRL+I
Audacity can import WAV, AIFF, AU, IRCAM, MP3 and OGG files. Please refer to the fileformats
page for further reference on these audio formats.
4. Playback
The imported file should now be displayed in an audio track. The track will look a little like this,
depending on what you imported :

Trackpanel and Waveform Overview of the imported Track
If you're not sure where to find audio material, simply rip some off a CD, or in Windows, check the
Media folder in the directory of your Windows installation.
Now click on the green Play button

at the top and you should hear the file you have just

imported.
Next part − Recording with Audacity
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Tutorial − I.Basics
Part 4 − Recording with Audacity − Part 4
1. Create a new project
Save an empty project. Or simply use the one from the previous part. Remember, that if you don't
save your project before you start recording or importing, that all recordings, edit and other files will
be written to directory set in the Directories preferences.
2. Check the preferences
Make sure your playback and recording device are set. If you're going to record a stereo signal,
check the "Record in stereo" checkbox in the Audio I/O preferences.
When picking a device to record from, make sure you've set up all the connections properly, such as
plugging a microphone in to the Mic Input, and any other device in to the Line In of your sound
card. Then check that the gain level knob(the amount by how much the input should be amplified) of
the mixer of your soundcard is set right.
Since most soundcards can mix the inputs back in to the outputs, the easiest way to test your
microphone is to speak in to it while playing with your sound card mixer. The sound card mixer is a
piece of software either provided by the sound card maker, or by the operating system you're using.
The Windows mixer is pretty straight forward, though some soundcards bring their own along. The
Mac's mixer is controlled via the Sound Control Panel, and the Linux users have a variety of mixer
applications at their disposal. Just make sure they work before yelling at your screen that nothing
works.
3. Hit Record
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Click on the red Record button

to begin recording.

Click on the blue Pause button

to pause the recording. Press it again to continue.

Click on the yellow Stop button

to cease recording. The cursor will return to its previous
position, before the recording was started.

That's it. You can now play around with your recording and explore the editing capabilities of
Audacity. Remember that you can use the Undo function almost without limits.
Proceed to the Editing for Beginners section, for a detailed overview of editing functions.
Back to the main page
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Introduction Cut,Copy&Paste Silence, Duplicate and Split Splitting and Submixes

II.Editing for Beginners
Part 1 − Introduction − Part 1
Sound Editing in the "real world"
Sound editors clean up dialogue tracks, cut layers of special effects, place sounds at certain times,
create ambiance tracks by cutting out unwanted stuff and mixing in interesting or necessary sounds.
Music production engineers may cut pieces of vocals away or shift them to a another spot in a song.
Editing is about cutting, placing, fading, cross−fading, shifting, duplicating and adjusting the volume
(also referred to as level) of audio material. Mixing is a form of editing too of course.
Here is an example of what is done in sound editing during the production of a television show or
film. In the next part we will run you through a few of those techniques in Audacity.
The Path of Sound in Film and TV Postproduction
Film and TV crews have at least two people present that take care of recording sound during
principal photography of a show. Principal photography is usually shooting the scenes with actual
live actors or real backgrounds by the way.
Sound in Principal Photography
The first person is the boom pole operator. The boom pole is an extendible stick with a microphone
attached to it. This is used to capture dialogue either during filming or not. When not filming, it
might be capturing off−scene dialogue or retakes of lines that the actors flunked during actual film
takes. The more expensive the show is and the more time there is to do the work, the more people
will resort to looping those takes, which is recording those lines in a sound studio environment
instead of a film studio or location.
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The second person is the sound mixer, who usually sits in a place farther off from the shooting and
records the sound captures by the boom pole operator, either via cable or wireless devices to tape,
optical disks or hard drive.
This is the raw sound material of a show. It is called production sound and the only desirable parts
it usually contains are dialogue and body sounds. In post production, depending on the complexity,
budget size and time, almost everything you hear except for the dialogue and some body sounds, are
added later during ...
Post Production
This is where most of the stuff we'll be describing for Audacity will happen. You've got the
recording. Now what ?
After the visual part of the show is cut, the first of which usually isn't the final one, it is handed to the
sound editor. In TV shows, you'll usually have one or two people for this, for major film productions
a whole bunch more, for which tasks will be subdivided on a finer level.
Raw sound − Cleanup time
No shows do without film edits and many have plenty of them.
Scenes may be shot with with one or more cameras and mics. Actors might have flunked their lines
and picking up shooting prior to the mistake might be chosen or the entire sequence reshot. The film
editor may have chosen parts from different takes for the cut of the scene. The action might be
moving along at the wrong pace and the film editor shortened or stretched parts of a scene.
The sound editor makes sure transitions between cuts are smooth. He or she removes undesired
sounds, such as breathers of the same person that overlap from one film edit to the next.
Material is cut away that contains unwanted sounds, such as creaking chair legs and sharp impacts of
objects on tables and floors. Some of these may require looping of dialogue in the studio, because the
noise may have been intolerable. Also, material may sometimes be de−noised. The most
sophisticated methods remove the whirring of the camera motors from takes. It is used as sparingly
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as possible though.
It's always desirable to get the best possible sound from the start, which is the recording stage.
Adding stuff − the really big deal
After this cleanup is complete, sounds are added.
The first is ambiance. Just close your eyes and listen the sound around you. That's ambiance.
Sophistication of ambiances rises with budgets. From premixed to over a dozen tracks, you'll find it
all in TV shows and feature films. In any indoor scene with a lot of people in the background,
nobody except for the actors being filmed will actually talk. That flurry of conversation is added later
on.
Next comes foley. These are clothes rustling(body sounds), foot steps and objects being handled.
People that have the ultimate edition of Terminator 2 will know that all of Arnold Schwarzenegger's
footsteps and rustle of his leather clothing were created by a five foot woman. These people are
usually called foley walkers or foley artists.
The foley editor then cleans those sound, chooses the most fitting takes and makes sure they all sync
to the picture properly. The foley mixer then does his/her thing.
Next come effects. Foley are effects too, but they are a special category and can best be described as
live created studio effects. Effects are usually more heavily edited and recorded from all kinds of
places. A lot of effects are created by layering sounds on top of each other, changing their pitch and
loudness, editing bits out and adding others.
Many effects you'll hear are phone and door bells ringing, mobile phone beeps, doors of houses and
cars opening and closing, weapon shots, slaps, car skids, machines of any kind, space ships flying
around, explosions, to name a few.
For example, a friend of mine and I created the sound of a small wooden rowing boat hitting a larger
wooden sailing ship and scraping along its side by pitching down a knock on a large wooden door
for the impact of the rowing boat and ship, and pitching down the sound of a skateboard rolling and
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scraping along a halfpipe.
The techniques required to properly handle sounds like these are used in all kinds of productions.
Audio books, music production, sound effects creation ... you name it.
For more on this subject, read the Audio Post FAQ at www.filmsound.org.
So let's jump in to the fray and look at how you can handle your sounds in Audacity.
proceed to
Part 2 − Cut,Copy&Paste.
Back to the main page
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II.Editing for Beginners
Part 2 − Cut, Copy and Paste − Part 2
From here on you may encounter funny letter combinations in boxes like this.
These are keyboard shortcuts to the functions presented to you in the text. These can be either single
keys (e.g. SPACE) or combinations that need to be held down at the same time(e.g.CTRL+C). You
can usually create your own. Check out the this page for more details.
The most basic editing step is cut and paste. It's what people did with tape and it's easy with data in
computers, so take a look at these basic operations, referred to as Cut, Copy and Paste. The next
page will handle Silence, Duplicate and Split. You may also want to check out the reference
section, so you'll know where to find all the tools and how to resize tracks for example.
It is assumed that you have a project open and that at least one track of audio material is present.
Let's take a look at this example of an Audacity window:

The View
The Audacity Window
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As you can see by the graphics above, the time shift tool
audio clip around inside its track.

is selected. It is used to move the entire

The cursor (little blinking line across a track and the timeline) will remain at its position, so
effectively you'll be sliding your audio material underneath the cursor.
Let's say we want to cut out that bit in the middle then. First we've got to select it.

Making a selection
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To select the part you wish to cut, copy or paste to, use the selection tool
so now by clicking on it in the toolbar.

. If it's not activated, do

Now press and hold the left mouse button while you drag the mouse to mark an area.
This area is darker than the surrounding area of the clip. Note, that even though you can mark an area
larger than or extending beyond the actual audio clip in the track, the operations will only work on
the actual clip. Playback however will work outside the clip.
Press the space bar to listen to the audio in the marked area.

To extend or contract your selection, hold down the SHIFT button and click on the area you wish
your selection to extend or contract to.
If you click at a spot that is on the right hand side from the middle of the current selection, you will
set the right hand boundary of your new selection.

Cutting the selection
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Cut the selection by selecting "Cut" from the Edit menu ...
Before the cut

or press CTRL+X.

After the cut

To undo this operation, select Undo in the Edit menu or press CTRL+Z
Copy will copy the selection to the clipboard.
You can then paste that data back in to any track by clicking where you want this audio to be
inserted and select Paste in the Edit menu,
or press CTRL+V.
Thus pasting is the opposite of cutting. You can also copy material, make another selection with the
mouse and then paste. This will replace the selected material with the contents of the clipboard, no
matter how short or long either of them are.
during all operations of this kind, the bottom row of the screen will display two things, namely the
start time and the end time of your selection. The display to the left if that called "Project rate:" and
its value, defaulting to 44100, can be changed by clicking on that number and selecting another from
the drop−down menu. This sets the sample rate of everything you produce in audacity.
All files, no matter which will be played at the project rate, and exported at that rate. Should the
sample rate of a track be different from the Project Rate, these tracks will be resampled to the
Project Rate as the project is played back or exported.
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Audacity will not change the sample rate of any imported audio. If you want to change the rate of an
imported track for any reason this can be done using the Rate option on the track pop−down menu.
proceed to Part 3 − Silence, Duplicate and Split.
Back to the main page

36

Audacity Manual Title Page

Back to the main page
Back to the Tutorial Page
Introduction Cut,Copy&Paste Silence, Duplicate and Split Splitting and Submixes

II.Editing for Beginners
Part 3 − Silence, Duplicate and Split − Part 3
Silencing unwanted sources
This operation flattens the selection. It essentially is a cut operation without deleting the selection
completely. After all, if you cut a second away, nothing remains. Using the Silence operation will
still leave you with a flatlined area.
When silencing parts between vocal lines, please keep in mind that a sudden drop in background
ambiance can have an bad effect, so at the very least fade the area around the silenced part, to
minimize that effect. Rules to start with are, fade in quickly and fade out slowly.
Alternately, use the envelope tool to lower the volume in that area. That way, you can comfortably
change it later.
Keyboard Shortcut : CTRL+L

Duplicate
The selected area gets copied, a new track is created and the copied material is pasted in to that new
track at the same point in the timeline.
To illustrate, here's the image from the menu reference:
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The benefits of a duplicate are many. One of these is experimentation with effects.
Some of you may say "I can do that with the original track too". But you can't change the volume of
your effect and original audio separately. If you put some Reverb on to your audio, you can only
lower that processed audio in volume later on. If you duplicate the audio first and use the reverb on
that(with 100% reverb and 0% original signal), you can freely change the volume for both the
original and reverb signal.
Also, you can do weird and wonderful things to your duplicates to create special effects. You'll have
two pieces of the same audio to work with. Silence parts, reverb another, phase a third, filter another
and see how that sounds. It is so easy to duplicate a piece of audio and do weird things to it, so try it.
Combining sounds produces magic.
A special note on performance :
The new piece of audio isn't actually copied on the hard disk. Audacity will still play from the
original audio file(s) until you change a piece of it.
Keyboard Shortcut : CTRL+D

Split
This performs the same as Duplicate, but it also silences the selected material, after copying it to a
new track. Again, here's the illustration from the menu reference:

There are plenty of good uses for this function, but I'm not going to tell you about them here. You'll
have to go to the next part for the meat of this tutorial.
Keyboard Shortcut : CTRL+Y
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go to
Part 4 − Splitting and Submixes.
Back to the main page
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Introduction Cut,Copy&Paste Silence, Duplicate and Split Splitting and Submixes

II.Editing for Beginners
Part 4 − Splitting and Submixes − Part 4
Moving bits of an Audio track
In all projects you'll be pushing your audio around at some point. Otherwise, what are you doing
here ?
There are techniques, easily achievable with Audacity, to cover almost any kind shifting you'd want
to do. In our example, we have a small sentence of speech, where the speaker made a pause after the
first word. We'd like to eliminate that pause.
The part after the pause is selected

Select

Then the split function is used to pop the selected audio to a new track
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Split

The Time Shift Tool

is selected and the audio on the lower track is moved left.

Move Audio and select for fading
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Now, it's a good idea to listen to the two tracks
individually for breathing sounds for example.
Use the solo button of the tracks for this. Then
listen them both in the mix. Again, you can use
the solo buttons for this.

Two thirds, and not the whole overlapping audio,
are chosen to keep the level of audio constant. If
the whole overlapping parts were faded, you
would get a level drop of 3dB in the middle of
those fades.

You can check this out by taking a piece of
music, duplicating it, and then fading the tracks,
one fading out, the second fading in. In the
middle of those fades, the level of the mix will
drop audibly. Do a fade over last two thirds for
the fade out and first two thirds for the fade in,
When you're satisfied, fade out the last two thirds and you probably won't notice any change in
level.
of the overlapping upper part of the track, and
fade in the first two thirds of the lower
Two thirds is a guideline, but not the law, so you
overlapping audio.
may have to experiment a little.
Mixing it back together again
If you have a lot of other tracks playing at the
same time, press the solo buttons on both tracks.
There should be no over lapping or cut−off
breathing sounds.

!!!Remember!!!
The final mix is done with the Export as WAV function in the File Menu. Here we'll be looking at
creating submixes with the Quick Mix function.
You've done a lot of edits and now have dozens of little tracks with little bits and pieces here and
there. It might look like this:
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Bits and Pieces spread all over the screen
First four tracks selected for quick mixing
We can use the Quick Mix function in the Project menu to bring down the number of tracks.
However, you don't need to mix everything in to one new track.
Select the tracks you want to mix together by SHIFT+click 'ing on the track panels. In the graphics
above, the first four tracks are selected.
Then select Quick Mix. In this example I have quick mixed everything down to two tracks :

Bits and Pieces, quick mixed down to two tracks
And thus, two submixes were created. Remember though, that we did this for convenience of not
having to organize a large number or tracks.
If you still want to shift bits around later on, you should make sure that the parts being mixed to a
track do not overlap, so you can split it away and edit it again later.
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Back to the main page

Back to the Tutorial Page
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Tutorial − III.Common Editing Tasks
Part 1 − Quickies − Part 1
This page will give you an idea of some of the possible things you can do with Audacity and walk
you through the process.
1. Splitting an MP3 into two separate files
2. Mixing background music with a voiceover
3. Recording harmonies with yourself
4. Recording two sound sources on separate tracks

Splitting an MP3 into two separate files
(Before you try to export MP3 files, read the
section on Exporting MP3 Files for some
important information on steps you need to do
first.)
• Open the MP3 file.
• Select the part of it that you want to be the
first file. Listen to it by clicking the Play
button.
• While this part is selected, choose Export
Selection as MP3... from the File menu.
• Now select the part you want to be the
other song and Export again.

Mixing background music with a voiceover

Recording harmonies with yourself
• Open the Preferences, click on the Audio
I/O tab, and check the box marked "Play
other tracks while recording new one".
• Click the Record button. Record yourself
singing. Click Stop.
• Click the Record button again. The first
track you recorded will play, but
Audacity will also record a new track at
the same time, allowing you to sing
harmony with yourself.
• When you play the two tracks you
recorded together, they probably won't be
synchronized. This is normal and is not
the fault of Audacity. To fix it, you will
need to grab the Time Shift tool and slide
one of the tracks around until it sounds
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Audacity makes it very easy to mix two different
sounds together.

right.

Recording two sound sources on separate tracks
• Open one sound (for example, the
background music).
• Open the Preferences, click on the Audio
• Select Import Audio... from the Project
I/O tab, and make sure "Record in Stereo"
menu and open the other sound (for
is checked.
example, the voiceover).
• Connect one sound source to the left
• Listen to your sound using the Play
channel of your soundcard and the other
button. Audacity automatically mixes
on the right. If you don't have an external
them together.
mixer with a pan control, use a
• Choose the Time Shift tool and adjust the
stereo/mono splitter cable.
position of one track or the other until
• Record your stereo track.
they're synchronized the way you want
• On the button with the track name is a
them. You can even move tracks around
drop−down menu. Select "Split Stereo
while they're playing.
Track" from this menu.
• If you hear clipping which wasn't present
• Use the drop down menu again to change
in either of the original files, it means that
each track to mono.
the combined volume of the two tracks is
• To position sounds in the stereo image use
too loud. Use the gain controls on the
the pan control on each track.
tracks to reduce the volumes until you
• To export your recording in stereo you
don't hear clipping anymore.
need to include at least one Stereo track.
• Export as a WAV or MP3 file.
If necessary add a blank one using Project
> New Stereo Track.
• Repeat as necessary for further tracks (see
Recording harmonies with yourself
above). If mastering from tape, a click
recorded across all tracks will help you
synchronize them in Audacity.
Back to the main page
Back to the Tutorial Page
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Tutorial − III.Common Editing Tasks
Part 2 − Editing Vocal Tracks − Part 2
The Situation
You have:
Vocals, Speech or Wallas (fx made with voices)
You want to:
• remove inappropriate breathers,
coughing, bad takes, parts you didn't like
and bad noises
• use only the good parts of takes
• construct sequences from parts of
different takes
When do I use what ?
The first option is a tool, but is rarely used by
itself.
In audio books, radio interviews and sometimes
in dialog for a film, the vocal tracks will stand
alone in many parts of your project.

You can combine three ways of handling this:
1. Silence stuff you don't want.
2. Substitute it with,
♦ a piece of ambience to prevent a
sudden hole in the sound texture
♦ more fitting breather, that works
better, if you're cutting a breather
away.
3. Use the envelope tool to create volume
automation to pull down those parts, so
they won't sound as loud in the end.

Continuous sound is the key in those cases and
having the ambience, even if it's just a bit of quiet
dark noise, drop away in many parts by silencing
them isn't going to sound as good as keeping a
steady sound texture.

Therefore filling those holes with material on
Therefore the second option is general practice. another track and fading the edges to make it all
Many times, the third option is used as
sound continuous is the preferred way to do it.
well(envelope tool). The holes you create with it
are easier to control and change at later times, but There are situations, such as vocals in a song, that
still need to be filled up with replacement
you'd like to sound as clean as possible.
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material.
When using the envelope tool, replacement
material is usually overlayed by placing the filler
material on another track right at the area in the
timeline as the hole is. For this reason only
silence unwanted audio if it's too obtrusive.
Bad takes are of course not usable, so usually
you'll have to cut that stuff away.
Just remember, that cut and delete(cut without
copying to the clipboard) work like cutting tape
away and sticking the remaining pieces together.
If you're doing things that require critical timing,
you need to keep this in mind. Use the Silence
function instead.
The Three Options − a quick How To

The best way is to have a very quiet recording
room or location.
The second best way is to use volume automation
to get rid of any unwanted stuff. It allows you to
change or take back what you did after you have
made those changes to the volume curve with the
envelope tool.
With volume automation you can mute sections
of the audio without actually making any edits to
the audio data.

Silencing
• Select an unwanted piece of audio.
• Listen to it a couple of times, adjust your selection if necessary, and listen again.
• Select Silence from the edit menu or hit CTRL+L on your keyboard.
• Fade the edges of the audio beyond your selection to smooth it out.
• Listen to it. If it doesn't sound good, hit Undo or press CTRL+Z on your keyboard, and try
again fading those edges.
• Repeat this procedure for every part you don't want in your audio.
Substitution
♦ Silence all unwanted bits as described in the section above. Substitution expands and
improves that option. Be sure to only silence the bits you don't want and don't forget to fade
the edges around the silenced material. Then come back here.
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♦ Now that you've silenced all unwanted, create a new audio track.
♦ Now find a piece of audio that'll work as a substitute for those deleted parts. This is usually a
piece of ambience somewhere else in the audio track. The speaker might have made a longer
pause, so look in those areas first. Select that bit and duplicate it.
♦ Using the time shift tool, move the duplicated ambience directly beneath the first silenced
part in your vocal track.
♦ Now select the entire track by clicking on track panel just beneath the Solo buttons, and
duplicate it. Mute that new track. This will be our filler for the next gap in the original track.
♦ Turn your attention back to the first bit of ambience, that is now right underneath the bit that
we silenced in our vocal track.
Using the Envelope Tool
• Switch to the envelope tool
• Left−Click in to an area to create a new automation point or left−click on an existing
automation point and drag to change the location of the point.
• The automation you have written remains bolted to the audio, so it will move along with the
audio when you use the timeshift tool.
• An example:

Using the envelope tool − an example
Back to the main page

Back to the Tutorial Page
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Tutorial − III.Common Editing Tasks
Part 3 − Cutting up long Tracks − Part 3
Long Recordings
You have:

You want to split it up in to parts that you wish
to be separate audio tracks on a CD.

a large audio file
(a mix, a live recording, loads of voice overs
recorded at once,...)
Splitting tracks for CD burning

You can cut it up, so all the parts can be selected
easily for export.

Important:
The selection format for the track that contains the audio clip to be split has to be :
cdda min:sec:frames 75fps (from ruler)
Also, "Set Snap−To Mode" to "On (for ruler based formats)"
The result is that all the tracks you split away will lie within the grid that not only CD players can
access, but that CD burning programs can actually burn without pauses.
That grid consists of 1/75th of a second, and beginnings and ends of any tracks on an audio CD
cannot lie outside that grid.

Chop By The Numbers:
The goal is to split the long audio track in to several smaller tracks, so that for each track we want to
have on the audio CD, there is one track in Audacity, which is easy to export.
1. Check and make sure that the right ruler format and Snap−To On is selected(see above) for
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track you're working on.
2. Place the cursor where you'd like the current track to end and the new one to start.
3. Go to the Edit menu and pick Select Cursor To End.
4. Go to the Edit menu and pick Split.
5. Repeat steps 1 to 4 as necessary.
You can also select from Start to Cursor instead. The track with the split away material will retain
the ruler and Snap−TO setting of its source track.

Get Them Ready for Deep Fry:
Once all the tracks are created you need to Export each Audacity track that you wish to be on your
CD. Check the preferences under "File Formats". The "Uncompressed Export Format" needs to be
set to "WAV (Microsoft 16 bit PCM) (PC or Linux users) or "AIFF (Apple/SGI 16 bit PCM)"
(Mac users).
1. Click on an empty part of the track panel(left of the wave display with the mute and solo
buttons) of the track you wish to export. The contents of that track will be selected.
2. Go to the File menu and pick "Export Selection as WAV" (or AIFF if you're on a Mac).
Pick your filename carefully. Number them accordingly, so it'll be easy to select them for
burning the audio CD later on.
3. Repeat steps 1 and 2 for each track you wish to be on your audio CD

Roast, Toast or Burn Them
Open your CD burning application to burn your audio CD with the exported audio files. Make sure
that no pauses are between those tracks. The only exception is the standard pause before the first
track. That's required by the Red Book standard, so don't be alarmed. Burn and enjoy.
Conclusion
That was easy, wasn't it. Think you know how this could work a lot easier ? Do you need additional
help or have suggestions on how to improve Audacity ? Drop us a line at
audacity−help@lists.sourceforge.net.
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IV.Effect for Beginners
Part 1 − A Virtual Room with Reverbs − Part 1
An example by the numbers
As an example I'd like to show you how to create a reverb for small club with a band.
Let's see what we have to do with parameters in the reverb fx in sample editors. First we determine
some basics about the room we want to simulate.
Our room(the club) is about eight meters on all sides(for simplicity) and three meters high. The band
will be playing no more than four meters away from us. The room volume will be about 200 cubic
meters.
This means that the DIRECT SOUND will get to you within about 11 ms (milliseconds). This is the
amount of time we'll need to take off the other values.
The first EARLY REFLECTIONS (off the left and right walls) travel around nine meters before
reaching you, so they'll get to your ears about 15 ms later! (9 meters at 343 meters/sec −> 26 ms
minus the 11 ms the DIRECT SOUND takes to travel to your ears).
I'm not taking the floor into account because of the obstacles, such as your own legs and a table, that
prevent reflections of sound from the band from reaching you. It is also probable that your sitting
close to a wall and EARLY REFLECTION time may drop considerably. Experiment and listen very
carefully.
The reason I'm deducting 11 ms from the 26 ms is that in a sample editor we already have the
DIRECT SOUND. In Cool Edit an EARLY REFLECTIONS parameter doesn't exist. In Soundforge
however there are a few ER times to choose from. We choose whatever is closest to 15 ms. Freeverb
unfortunately does not have an Early Reflections feature.
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Please note that the timing of the EARLY REFLECTIONS are defined by the rooms characteristics
such as shape and size. The sound colour of the EARLY REFLECTIONS is defined by the surfaces
in the room.These are parameters that are available to professional reverbs only(hard− or software),
so don't worry about not finding that stuff in great detail in either Soundforge's, CoolEditPro's or
plugins of other editors.
The PRE−DELAY and REVERB TIME depend on more than just room size. Wall and floor
material, as well as anything else that reflects, disperses and dampens sound will influence the reverb
in quite a few ways.
Our club has lots of wood on it's walls and floor and people are sitting at tables and the air's probably
filled with a little smoke(except in California :).
The REVERB TIME, a parameter found in almost all plugins, should be set to no more than one
second. In small, crowded rooms where little REVERB occurs it is quite important to set the
EARLY REFLECTIONS right. Experiment with the reverb time keep it lower than 1.2 seconds and
above 0.7 seconds. Freeverb puts all this information in to the SIZE parameter.
The PRE−DELAY can be set to 30 ms or more. Larger rooms will develop REVERB later since the
reflecting sound will travel a while before the reflections become hard to identify but it also depends
on the reflecting materials. Freeverb once again doesn't know any Predelays, but since you're reading
this to learn how things work, it's still worth spelling out.
Both Cool Edit and Soundforge have parameters referring to the DENSITY of the REVERB part of
the sound. Materials such as polished marble will reflect the sound very well and disperse the sound
very little. Wood disperses the sound a lot and a carpet practically swallows a large chunk of it. For
our Club we need to set the density high since our material disperses the sound a lot(humans,wood
and obstacles). No parameter like that in Freeverb and yet it sounds great. It's easy to use as well, so
I don't really mind when using it.
Higher frequencies are swallowed a lot faster than low frequencies. Many reverb algorithms refer to
this in some form or another. Cool Edit has the 'High Frequency Absorption Time' as a parameter for
this. Sound Forge gives you a choice, whether to do this at all for both low and high frequencies and
even lets you set them but doesn't provide any time parameters. Professional Reverb hardware such
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as Lexicon PCM 70,80&90 let you you control frequency and time of this, for low and high
frequencies. Freeverb has the DAMPEN parameter for this.
This can effectively add to room's liveliness. A room full of people will absorb high frequencies a lot
faster than an empty room, in which only the materials would make the difference, so in Cool Edit
we'll set the 'High Frequency Absorbtion Time' very low, since we're in a crowded club. For
Soundforge activate the 'Attenuate high frequencies above' box and set the frequency parameter to
around 2000−2500 Hz. Experiment a bit. The higher this frequency and the longer the Absorbtion
Time parameter in Cool Edit, the emptier and and colder your room will seem. In small rooms this
can cause the room to sound very metallic. Sewer pipes and oil pipelines e.g.
The Reverb EQs are the final processing stage and can change the sound dramatically. These Hishelf
and Lowshelf EQs are found in almost ANY Reverb plugin and hardware unit. Freeverb has both in
form of Hipass and Lowpass filters. These are not EQs. The parameters change the target frequencies
of the filters. Again, listen.
The last thing you have to do is set the balance between the WET signal and your original DRY
signal. Here you can do as you please but remember that only very smoothed hard surfaces in big
cavernous space create very loud reverbs. A church might do that if there aren't a big number of
people and wooden benches in there, but a club doesn't :). Remember that in Audacity it is smarter to
DUPLICATE the part you wish to add reverb to, and run the effect over that duplicate. The volume
of that reverbed material is easier to control, so set the WET parameter in Freeverb to 0dB(−>100%)
and the DRY parameter to −endless(−>0% left most slider position).
So when you create your next 'soon−to−be−the−hit' song or want to put things in perspective, be sure
to check the possibilities of adding dimension and scope to your material through clever use of
reverbs. Put your snare to the front, the piano a little to the back, and the sax just a little in front of
the drums. Experiment. With these basics you'll be able to get better results in less time.
Btw, Snare always gets reverb. How much and what kind up to you, but it's generally good thing. It's
also important to decide whether you're trying to simulate a real live band or doing a multitrack
sound, which boasts all kinds of nice ideas, like doubling(another take of the same thing on top of
the first take), extreme panning and in general NOT reality :).
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Dry versus Wet
Have you heard of those silent rooms, where they test speakers and microphones ? They're great if
you don't happen to be inside of one. After a few minutes you hear the blood in your ears roar like an
ocean. You hear only your inner voice when you speak. The room swallows almost everything else.
Most people can't stand being in a room like this for more than 10−15 minutes. I am told that this is
very different to wearing ear plugs. Those only attenuate sound from the outside. A silent room kills
it completely.
This room is horrible to listen to, because it basically features no room reverberation, i.e. it doesn't
reflect anything at all. It doesn't reveal any information about its size or surface composition.
You may be surprised to know that many vocals are actually recorded in similar environments.
Vocal booths are little rooms, in which the walls reflect sound as little as possible. During mixing,
digital reverbs are used to create a virtual space.
Digital Reverbs
Audacity for Windows and MacOS8&X includes the VST plugin Freeverb, which is one fine
reverb, and ideally suited to take your first steps with digital reverbs. It features simple controls that
require little explanation.
For details about Freeverb, check out the effects menu page. For information on how digital reverbs
work and what reverb is, check out this page of this manual.
Keeping effects on seperate tracks
You shouldn't use reverbs on original audio tracks. First duplicate the audio and use the reverb on
that duplicate. The reverb should be set to output 100% WET (i.e. 100% effect signal and 0% of the
original signal). That way, you can control how much reverb should make it in to the final mix, right
up until the last minute.
Back to the main page

Back to the Tutorial Page
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V.Selecting and aligning
Part 1 − Selecting − Part 1
Basic rules
Selecting can be done with the keyboard, the mouse or by combining the keyboard and mouse.
You need to have the Selection Tool

activated for making a selection.

The exception is selecting the entire track by clicking on the track panel. The align functions all still
work the same way no matter which tool is activated. However, making selections and placing the
cursor still requires the Selection Tool.
The selection modifier key is SHIFT.
In a word processor or text editor, the SHIFT key is the modifier to turn any character that you enter
via the keyboard in to an UPPERCASE character. In Audacity and most audio editing applications,
holding down the SHIFT key means that any cursor movement or placement will result in a
selection.
What follows are ways of making selections.
How do I ...
select audio on one track ?

select all the audio of a track ?

Place the cursor on the waveform of a track, hold Click on the track panel. The resulting selection
down the mouse button, drag the mouse and
will be confined to the contents of that track.
release the mouse button.
You can select audio with the keyboard as well, select all the audio of two or more tracks ?
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but may need to place the cursor with the mouse
first. You need to hold down the SHIFT key and
use the left/right cursor keys to expand the
selection. Combine the former with the CTRL
key (STRG on the German keyboard) to shrink
the selection.
expand/shrink my selection ?
Hold the SHIFT key, then click and hold the
mouse button.
If you clicked to the left of the center of the
current selection, you will now be able to move
the left selection boundary with your mouse. The
same goes for the right hand side of the selection
center. Release the mouse button when you are
satisfied.
You can use the cursor keys as well. It works the
same way as described in the previous item.

It cannot be done precisely right now, if one track
isn't within the range of the other.It actually
doesn't have to be, because of the group functions
in the Align menu, but more of that later.
If the start and end of one track is within the start
and end of the other, simply select the longer
track, then SHIFT + click the second track panel.
If the start and end of one track is not within the
start and end of the other, select the one track,
then expand the selection by SHIFT + clicking in
to the second track until the selection
encompasses all the desired material.
select all the audio of the project ?
Use the Select All function in the Edit menu, or
hit CTRL+A.

select from the cursor to the start of the track ?
Use the Start to Cursor function in the Edit menu.
select from the cursor to the end of the track ?
Use the Cursor to End function in the Edit menu.
select from the cursor to the start of the project ?
Hold the SHIFT key and click on the Skip to
Start button.
select from the cursor to the end of the project ?
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Hold the SHIFT key and click on the Skip to End
button.
Back to the main page
Back to the Tutorial Page
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File Menu
New...

Export Selection As WAV...

Creates a new empty project window.

This is the same as Export, but it only exports the
part of the project that is selected. This is very
useful if you want to save a small clip from part
of a track as a separate file.

Open...

Selecting Open presents you with a dialog where
Export As MP3...
you can choose a file to open. If the current
project window is empty, the new file will take
over the current window, otherwise a new project Exports the current Audacity project as an MP3
file. Audacity does not encode MP3 files directly,
window will be opened.
but instead requires that you download a separate
MP3 encoder. See Exporting MP3 Files for
The file formats recognized by Audacity are
details.
WAV, AIFF, NeXT/AU, IRCAM, MP3,
Ogg Vorbis, MIDI, and the Audacity Project file
To export only a single track or part of track, use
format (AUP).
Export Selection as MP3.
In addition, Audacity can also attempt to open an
audio file in a different format, as long as it is
uncompressed − to do this, use the Import Raw Export Selection As MP3...
Data command.
This is the same as Export MP3, but it only
exports the part of the project that is selected.
This is very useful if you want to save a small
Close
clip from part of a track as a separate file. See
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Closes the current project window.

Exporting MP3 Files.

Save Project

Export As OGG...

Exports the current Audacity project as an Ogg
Saves the current Audacity project (AUP) file.
Audacity projects are not intended to be read by Vorbis file.
other programs, but they are extremely fast to
To export only a single track or part of track, use
load and save within Audacity. When you are
finished working on a project and you want to be Export Selection as Ogg.
able to use it in another program, select one of the
Export commands instead.
Export Selection As OGG...
Note that most of the audio data for an Audacity
This is the same as Export As OGG, but it only
project is not stored in the AUP file, but in a
exports the part of the project that is selected.
directory (folder) with the same name as the
This is very useful if you want to save a small
project. For example, if you save a project as
chanson.aup, there will be a directory called clip from part of a track as a separate file.
chanson_data created to store the actual
audio tracks of the project. For more information Export Labels...
on the project file format, see the file formats
page.
If you have any Label Tracks, this command will
export them as a text file. This feature is
commonly used in Speech Recognition research
Save Project As...
to annotate a speech utterance and export the
annotation to be later processed by another
program.
Saves the current Audacity project (AUP) file,
allowing you to give it a different name or move
it to a new location if you have already saved it in To import these labels into a different project
one location.
later, use the Import Labels command.
Audacity projects are not intended to be read by
other programs, but they are extremely fast to
load and save within Audacity. When you are

Export Multiple...
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finished working on a project and you want to be This allows you to do multiple exports from
able to use it in another program, select one of the audacity with one command based either on
multiple tracks in the project or labels in a single
Export commands instead.
audio track. It's great for splitting up long
For more information on the project file format, recordings into CD tracks
see the file formats page.
Preferences
Export As WAV...
Opens a dialog window that lets you configure
Exports the current Audacity project as a standard Audacity. For more information on the different
preferences, see the section on Audacity
audio file format such as WAV or AIFF.
Preferences.
You can change the format of exported files in
the Preferences dialog.
Exit/Quit
If there are multiple tracks in your project, they
will be automatically mixed in the exported data. Closes all project windows and exits Audacity. It
will ask you if you want to save changes to your
For more information about mixing, see Quick
project. It is not necessary for you to save
Mix.
changes if you just exported your file as WAV or
MP3 and you are finished working with it. On the
To export only a single track or part of a track,
other hand, if you are working on a mix and plan
use Export Selection.
to continue where you left off, saving an
Audacity Project will let you restore everything
as it is later.
Back to the main page

Back to the Reference page
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Edit Menu
Undo

Copy

This will undo the last editing operation you
performed to your project. Audacity currently
supports full unlimited undo − meaning you can
undo every editing operation back to when you
opened the window.

Copies the selected audio data to the clipboard
without removing it from the project.

Redo

Paste
Inserts whatever is on the clipboard at the
position of the selection cursor in the project,
replacing whatever audio data is currently
selected, if any.

This will redo any editing operations that were
just undone. After you perform a new editing
operation, you can no longer redo the operations
Trim
that were undone.

Deletes everything but the selection.
Cut
Removes the selected audio data and places it on
the clipboard. Only one "thing" can be on the
clipboard at a time, but it may contain multiple
tracks.
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Delete

Split

Removes the audio data that is currently selected Moves the selected region into its own track or
tracks, replacing the affected portion of the
without copying it to the clipboard.
original track with silence. See the figure below:
Silence
Erases the audio data currently selected, replacing
it with silence instead of removing it completely.

Duplicate
Makes a copy of all or part of a track or set of
tracks into new tracks. See the figure below:

Select... > All

Selection Save

Selects all of the audio in all of the tracks.

Saves the current selection and position. This
function only saves the selection boundaries, but
not the actual audio data.

Select... > Start to Cursor
Selects all the audio from the start of the timeline Selection Restore
to the current cursor.
Restores the selection to the project. You need to

66

Audacity Manual Title Page

Select... > Cursor to End

have an exist selection for this to work.

Selects all the audio from the cursor to the end of
project, which is as far as audio exists in the
Move Cursor...
project.
These commands provide quick and accurate
ways to manoeuvre the cursor around the project
to the start and end of tracks and selections.
Find Zero Crossings
Moves the cursor or the edges of the selection to
Snap−To...
the nearest point where the audio waveform
passes though zero. Use this to help achieve
click−free cuts in audio, as the two ends of the
Turns snapping of the cursor to a grid of time
cut will exactly line up.
values on or off. When off, your cursor can be
positioned on any sample in the audio file. When
on, it is restricted to certain points in time,
determined by the time format in use. This is
useful if your project must follow an external
timecode exactly.
Back to the main page

Back to the Reference page
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View Menu
Zoom In

History

Zooms in on the horizontal axis of the audio,
displaying more detail about less time. You can
also use the zoom tool to zoom in on a particular
part of the window.

Brings up the history window. It shows all the
actions you have performed during the current
session, including importing. The right−hand
column shows the amount of HD space your
operations used. You can jump back and forth
between editing steps quite easily by simply
clicking on the entries in the window.

Zoom Normal

Zooms to the default view, which displays about The history window can be kept open at all times.
It doesn't interfere with any other operations.
one inch per second.

Zoom Out

Plot Spectrum

Zooms out, displaying less detail about more
time.

To use this feature, first select a region of audio
from a single track, then select "Plot Spectrum".

Fit in Window
Zooms out until the entire project just fits in the
window.

It opens up a window which displays the Power
Spectrum of the audio over that region, calculated
using the Fast Fourier Transform. The graph
represents how much energy is in each frequency.
This window can also display other common
functions that are calculated using the Fast
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Fit Vertically

Fourier Transform, including three versions of
the Autocorrelation function.

Adjusts the height of all the tracks until they fit in
The Enhanced Autocorrelation function is very
the project window.
good at identifying the pitch of a note.
Zoom to Selection
Float or Dock Control Toolbar
Zooms in until the selected audio fills the width
of the screen to show the selection in more detail. Toggles between displaying the tool docked at
the top of each project window, or in a separate
floating window. You can also float any toolbar
by grabbing the handle on the left side and
Set Selection Format
dragging it to the location you want.
Sets the format in which selections are measured
Once they are floating these options change to
in at the bottom of the application window.
docking the toolbars back into the main window.
Combined with setting Set Snap−To Mode to
ON, this is ideal to cut stuff up in to exact
Float or Dock Menu Toolbar
measures.
Set Snap−To Mode

Float or Dock Mixer Toolbar
Float or Dock Meter Toolbar
Do the same thing for the other toolbars

Back to the main page

Back to the Reference page
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Project Menu
Import Audio...

Quick Mix

This command is used to import audio from a
standard audio format into your project. Use this
command if you already have a couple of tracks,
and you want to add another track to the same
project, maybe to mix them together.

This command mixes all of the selected tracks
down to one or two tracks. The channel of a track
being mixed affects whether it will be mixed into
the left channel of the resulting track(s), the right
channel, or both (mono).

Use this command to import anything except
MIDI files. You cannot yet use this option to
import Audacity Projects.

For example, if you have four tracks:

Import Labels...
This command takes a text file which contains
time codes and labels, and turns them into a
Label Track.

• Track 1: left channel
• Track 2: left channel
• Track 3: right channel
• Track 4: mono channel
and you select them all and perform a Quick Mix,
you will end up with two tracks: the first will
contain a mix of tracks 1, 2, and 4 (the new left
channel) and the other will contain a mix of
tracks 3 and 4 (the new right channel).

Import MIDI...
Your tracks are implicitly mixed whenever you
This menu command imports MIDI files and puts hit the Play button and whenever you select
Export.
them into a Note Track. Audacity can display
MIDI files, but cannot play, edit, or save them
yet.

70

Audacity Manual Title Page

Note that if you try to mix two very loud tracks
together, you may get clipping (it will sound like
This menu command allows you to open a file in pops, clicks, and noise). To avoid this, you
should use the track gain controls to reduce the
virtually any format, as long as it is not
compressed. When you select the file, Audacity amplitude of all of your tracks.
will look through it and try to guess its format. It
will guess correctly about 90% of the time, so
you can try just pressing "OK" and listening to it. New Audio Track
If it is not correct, however, you can use the
This creates a new empty audio track. This
dialog presented to try all of the different
command is rarely needed, since importing,
possibilities.
recording, and mixing automatically create new
At the beginning of your imported track(s), you tracks as needed. But you can use this to cut or
may notice a little bit of noise. This is probably copy data from an existing track and paste it into
the file's header, which Audacity was not able to a blank track.
parse. Just zoom in and select the noise with the
Selection Tool, and then choose Delete.
New Stereo Track
Import Raw Data...

Creates a stereo version of the new audio track
above. You may need this if you start with a load
Opens a dialog allowing you to edit the ID3 tags of mono tracks and want to export a stereo mix.
associated with a project, for MP3 exporting.
Edit ID3 Tags...

ID3 Tags are used to store the Title, Artist,
Author, and other information in MP3 files.
When you import an MP3 file, Audacity
remembers this information and stores it with
your project. When you export an MP3 file,
Audacity will prompt you for the ID3 tags,
showing you any tags it collected from an
original MP3 file, or that you typed by selecting
"Edit ID3 Tags" from the Project menu.

New Label Track
This creates a new Label track, which can be very
useful for textual annotation. See the discussion
on Label tracks for more information on how to
use label tracks.

New Time Track
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Audacity allows you to store ID3 tags in either
the ID3v1 or the ID3v2 format. In general, you
should use the ID3v2 format, because ID3v2 tags
go at the beginning of an MP3 file, whereas
ID3v1 tags go at the end. Having the title and
author first means that someone downloading an
MP3 you created will know that information
before they've finished downloading the song.

Creates a special track that can be used to speed
up and slow down playback over the course of
the project. This affects all tracks in the project.

Remove Track(s)
This command removes the selected track or
tracks from the project. Even if only part of a
track is selected, the entire track is removed. You
can also delete a track by clicking the X in its
upper−left corner. To cut out only part of the
audio in a track, use Delete or Silence.

Align functions
All the align functions work on whole tracks or groups of tracks, NOT on selections, even if they
span across multiple tracks. Please read the tutorial on how to use the align functions. You will also
find some creative uses and solutions to common problems there.
These functions operate on each track individually. If more than one track is selected, these
functions do not preserve their position to one another.
Align with Zero

Align End with Cursor

Aligns the start of any selected tracks to the start Aligns the end of any selected tracks to the cursor
of the project.
position.

Align with Cursor

Align End with Selection Start

Aligns the start of any selected tracks to the
cursor position.

Aligns the end of any selected tracks to the start
of the current selection
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Align with Selection Start

Align End with Selection End

Aligns the start of any selected tracks to the start Aligns the end of any selected tracks to the end of
the current selection
of the current selection

Align with Selection End

Align Tracks Together

Aligns the start of any selected tracks to the end
of the current selection

If you select multiple tracks, this command
adjusts their time offset so that they start at the
same time. It adjusts their starting time to the
average of all of the tracks' original starting
times. To adjust the time offset of one track, use
the Time Shift tool.

Align and Move Cursor
These commands work just like the align commands with the move cursor command immediately
following it.

Add Label at Selection
This menu item lets you create a new label at the
current selection. You can title the label by typing
Add Label at Selection
with the keyboard and then hitting "Enter" when
you're done. The label saves your current
Like Add Label at Selection but the label is added
selection − so when you click on the label later it
at the current position during playback.
will return the selection to the state it was in
when you created the label. See the discussion on
Label tracks for more information on how to use
label tracks.
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Generate Menu
Silence

Tone

Inserts silence. The length is determined by the
length of your selection and the position by the
left boundary of your selection.

Inserts a wave of chosen type, frequency and
amplitude. The length is determined by the length
of your selection and the position by the left
boundary of your selection.

If no selection is made, the default length inserted
If no selection is made, the default length inserted
at the cursor position is 30 seconds.
at the cursor position is 30 seconds.
For example, to insert a two seconds of silence at
Parameters:
a certain point, place the cursor at your chosen
spot, hold the SHIFT key down, click and drag
your mouse to the right to mark roughly two
Waveform
Sine, Square, Sawtooth
seconds, release the mouse button and activate
Frequency(Hz) 1−20000 (value below 1.0 and
the Silence function in the Generate menu.
above 20000 will be corrected to
Silence, the length of your selection, will be
1.0 and 20000!)
inserted at the left boundary of your selection.
Amplitude
0−1 − This is the volume of the
generated wave.
White Noise

Pluck

Inserts white noise. The length is determined by Inserts a synthesized pluck tone. The length is
the length of your selection and the position by determined by the length of your selection and
the left boundary of your selection.
the position by the left boundary of your
selection.
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If no selection is made, the default length inserted If no selection is made, the default length inserted
at the cursor position is 30 seconds.
at the cursor position is one second.
Pitch

Back to the main page

0−127
The number corresponds to the value
of a midi note, which is assigned to a
pitch. The higher the number, the
higher the note.

Back to the Reference page
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Effects Menu
Audacity includes many built−in effects and also lets you use a wide range of plug−in effects. You
can download many free plugins for Audacity at our Website. Loads of information is also available
at http://www.kvr−vst.com.
To apply an effect, simply select part or all of the tracks you want to modify, and select the effect
from the menu. Titles which end in an ellipsis (...) will bring up a dialog asking you for more
parameters.
There are four classes of effects and they are all applied the same way. These are
Internal Effects, VST Effect Plugins(Windows/Mac only), Nyquist Effects and LADSPA Effects

Internal Effects
Amplify...

Invert

This effect increases or decreases the volume of a
track or set of tracks. When you open the dialog,
Audacity automatically calculates the maximum
amount you could amplify the selected audio
without causing clipping (from being too loud).

This effect flips the audio samples upside−down.
This normally does not affect the sound of the
audio at all. It is occasionally useful, for example
when the left and right channels of a song both
contain equal amounts of vocals, but unequal
amounts of background instruments. By inverting
one of the channels and not the other, the vocals
will cancel each other out, leaving just the
instrumentals. Obviously this only works if the

Bass Boost...
This is a safe, smooth filter which can amplify
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the lower frequencies while leaving most of the exact same vocal signal is present in both of the
other frequencies alone. It is most effective if you channels to begin with.
don't try to boost too much; 12 dB is usually just
Noise Removal...
right.
Echo...
A simple delay line.

This effect is ideal for removing constant
background noise such as fans, tape noise, or
hums. It will not work very well for removing
talking or music in the background.

This effect repeats the audio you have selected
again and again, softer each time. There is a fixed Removing noise is a two−step process. In the first
step, you select a portion of your sound which
time delay between each repeat.
contains all noise and no signal, in other words,
First select the audio you want to apply the effect select the part that's silent except for the noise.
to. You may want to first add silence to the end Then choose Noise Removal... from the Effect
menu and click Get Profile. Audacity learns from
of your track(s) so that the echo has plenty of
time to die out. When you select "Echo..." from this selection what the noise sounds like, so it
the Effect menu, Audacity will ask you for two knows what to filter out later.
numbers.
Then, select all of the audio where you want the
The first number is the amount of delay between noise removed from and choose Noise
Removal... again. This time, click the "Remove
the echos, in seconds. The second value is the
decay factor, which is a number between 0 and 1. Noise" button. It may take a few seconds or
A decay factor of 0 means no echo, and a decay longer depending on how much you selected.
factor of 1 means that each echo is just as loud as
If too much or not enough noise was removed,
the original. A value of 0.5 means that its
amplitude is cut in half each time, so it dies out you can Undo (from the Edit menu) and try
slowly. Smaller values will make it die out even Noise Removal... again with a different noise
removal level. You don't have to get a new noise
more quickly.
profile again if you think the first one was fine.
The Echo effect is very simple and is not
intended to be used in place of a Reverb effect, Removing noise usually results in some
distortion. This is normal and there's virtually
which simulates the sound of a room, concert
nothing you can do about it. When there's only a
hall, stage, or other natural environment.
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little bit of noise, and the signal (i.e. the voice or
the music or whatever) is much louder than the
noise, this effect works well and there's very little
audible distortion. But when the noise is very
Note that if you set the decay value to 1.0, you
can use Echo to create loops that repeat as long as loud, when the noise is variable, or when the
signal is not much louder than the noise, then the
you want any never change volume.
result is often too distorted.
Fade In
Future versions of Audacity may include
Applies a linear fade−in to the selected audio. For improved versions of this effect.
a logarithmic fade, use the envelope tool.
Phaser...
Fade Out
The name "Phaser" comes from "Phase Shifter",
Applies a linear fade−out to the selected audio. because it works by combining phase−shifted
signals with the original signal. The movement of
For a logarithmic fade, use the envelope tool.
the phase−shifted signals is controlled using a
Low Frequency Oscillator (LFO).
FFT Filter...
Audacity for MacOS and Windows comes with
Gverb, a free LASPA Reverb plug−in.

This is the most general type of filter. You define
a curve that shows how much louder or quieter
each frequency in the signal should be made.
If you're careful, you can use it to highlight
exactly the frequencies you want. However,
doing an FFT filter is more likely to result in
artifacts, especially if the filter you draw is not
smooth.

Reverse
This effect reverses the selected audio
temporally; after the effect the end of the audio
will be heard first and the beginning last. Some
people reverse small portions of audio to make
inappropriate language unintelligible, while
others believe you can hear subliminal messages
if you listen to speech backwards. You can also
create interesting sound effects by recording
natural events and reversing the audio.
Wahwah...
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Just like that guitar sound so popular in the
1970's.
This effect uses a moving bandpass filter to create
its sound. A low frequency oscillator (LFO) is
used to control the movement of the filter
throughout the frequency spectrum.
The WahWah effect automatically adjusts the
phase of the left and right channels when given a
stereo recording, so that the effect seems to travel
across the speakers.

VST Plug−ins
To use a VST plug−in effect, put the effect in the directory (folder) called "Plug−Ins", which should
be in the same directory where Audacity resides. If there is no directory, create one. You will also
need to download and unzip the VST Enabler to the same directory. The next time you launch
Audacity, any plug−ins you added will appear in the Effect menu.

Freeverb2...
Audacity for Mac OS and Windows comes with a
VST plug−in called Freeverb, which is in version
2 (hence "Freeverb2"). This effect implements a
versatile and high−quality reverb effect.

If you set the dry level to 0 and the wet level to
−infinity, it's like standing right in front of the
singer in a tiny room − all you can hear is the
singer, and no reverb. A good place to start is to
set both the dry level and wet level to 0 dB.
Getting a good reverb sound depends a lot on the However, you may want to experiment with
source audio and can take a lot of
lowering the dry level while you are
experimentation. One good strategy is to select a experimenting with the sound of the reverb.
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small portion of audio (a few seconds) and try to
add reverb. Listen to it, then Undo and try it
again with different settings. Keep doing this
until you've found the settings you like the sound
of best, and then Undo one last time, Select All,
then apply the effect to your entire recording.

The room size parameter is self−explanatory. The
smallest room size setting creates a quick, bright
reverb, while the largest setting creates a long,
drawn−out, and dark reverb. The damping
parameter controls how the sound bounces off the
walls − i.e. if it is mostly reflected or absorbed.

There are a lot of parameters to Freeverb2: Room The predelay controls the delay between the dry
signal (unreverberated) and the wet signal
size, Damping, Predelay, Lowpass, Highpass,
(reverberated) − usually there is some predelay
Wet level, and Dry level.
because of the time it takes sound waves to travel
Let's start with the wet and dry levels. Freeverb from the sound source to the nearest wall, and to
works by taking your audio signal and modifying the microphone. Larger predelays are suitable for
it to create the reverberated sound, i.e. the sound creating an effect of a larger room.
you hear echoing off the walls of the room. This
Finally, the lowpass and highpass filters can be
is called the "wet" part of the effect.
used to make the reverberated sound lower or
higher. Increasing the lowpass filter filters out the
This is mixed together with the original sound,
high frequencies, and similarly increasing the
which is called the "dry" part of the effect, to
highpass filter filters out the low frequencies.
produce the combination of direct
(unreverberated) and indirect (reverberated)
sound, which is what you would naturally hear. If
you set the dry level to −infinity and the wet level
to 0 dB, the result is something like standing
outside of a concert hall: you can only hear the
reverberated sound.

Nyquist Plugins
To use a Nyquist effect, put the effect in the directory (folder) called "Plug−Ins", which should be in
the same directory where Audacity resides. Upon installation, some nyquist scripts are included, so
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you needn't worry about creating this directory. The next time you launch Audacity, any plug−ins
you added will appear in the Effect, Generate or Analyse menus.

LADSPA Plugins
These started out a a plugin format for Linux, but can now be used on Windows and OS X as well.
There are lots of free plugins available, and no enabler is needed. More information can be found on
the web.
Back to the main page

Back to the Reference page

82

Audacity Manual Title Page

Back to the main page

Back to the Reference page

FileEditViewProjectGenerateEffectAnalyze

Analyze Menu
Note: plugins that accept input but produce no output will be placed in the Analyze menu. By
default, this menu is often empty.
Beat Finder

Sample Analyze Nyquist Plugin ...

no documentation available yet

Will place labels that mark the beginning and end
of a selection.

Back to the main page

Back to the Reference page
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Preferences
Audio I/O
• The two drop−down list controls in this pane is where you configure which device Audacity
should use for sound input and output. This basically means which sound card, USB sound
device, etc you want to use. If your sound card support multiple sound inputs, e.g. has a
microphone input and a line−in, then you select these on the mixer toolbar. No need to adjust
this if Audacity is already playing to and recording from the correct place.
• Record in Stereo: If this is checked, recordings you make in Audacity will be stereo,
otherwise they will be monaural. Note that the interpretation of mono recordings depends on
your system − on most systems making a mono recording of a stereo input will result in the
two channels being mixed, but on other systems it could give you just the left channel, for
example.
• Play other tracks while recording new one: Check this box if you want to record multiple
tracks over top of one another! Record the first track as usual. Then, with this box checked,
click record again. The first track you recorded will play, but Audacity will also record a
new track at the same time, maybe allowing you to sing harmony with yourself or add
real−time sound effects to a recording.
You may notice that when you play the two tracks you recorded together, they aren't
synchronized. This is normal and is not the fault of Audacity. To fix it, you will need to grab
the Time Shift tool and slide one of the tracks around until it sounds right.
• Hardware Playthrough (Mac Only): This sets up your computer to send the sound coming
in to be recorded straight back out of the speakers, so you can hear what you are recording.
Hardware playthrough has no latency and takes no CPU, but is only possible if your input
and output are on the same audio device, and that device supports it.
Windows and Linux users can enable this using your operating system's Mixer, by simply
turning up the level for the input you are using and unmuting it.
• Software Playthrough: This enables you to hear what you are recording by taking the data
about to be recorded by audacity, and playing it back out of the sound card. This works with
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any duplex sound card, or combination of sound devices, so you can record in through an
external USB device and play back through the computer's built in sound device or vice
versa.
Because of the delays in processing the audio on the computer, there will be some delay or
latency in the sound that you hear. It also needs some CPU power, so if you have an old
machine and are getting breaks in your recordings try turning it off.

Quality
This panel sets the default sample rate and bit depth for new projects. It does not affect any existing
project − to change the sample rate of an existing project, just click on the rate at the bottom of the
window and select a new rate from the pop−up menu.
The bit depth affects imported material, if it's copied, as well as newly recorded material. The
advantage of the 32−bit float resolution is that effects return material at a this resolution, which
improves the final mix, because the computer has more precise material to work with. If you aren't
doing any processing then you may want to save some space by setting this to 16 bit, if your
hardware supports this.

File Formats
• When importing uncompressed audio files...
♦ Make a copy of the file to edit: selecting this means that Audacity will run a little bit
slower, but it will always have its own copy of any audio you are using in a project.
You can move, change, or throw away your files immediately after you open or
import them into Audacity.
♦ Edit the original in place: selecting this operation means that Audacity depends on
your original audio files being there, and only stores changes you make to these files.
If you move, change, or throw away one of the files you imported into Audacity,
your project may become unusable. However, because Audacity doesn't need to
make copies of everything, it can import files much more quickly this way. If you
want to send projects to other people or archive them, then select this option.

85

Audacity Manual Title Page

• Uncompressed Export Format: This lets you select the format that Audacity will use when
you export uncompressed files, i.e. anything other than lossy formats, such as OGG and MP3.
Audacity can output a huge amount of different formats with the Other option, which lets you
define any aspect of the multitude of different formats.
For most users, 16 bit WAV (Microsoft) or AIFF (Mac) files will be the most compatible.
• Ogg Export Setup: Use this control to set the quality of Ogg Vorbis exporting. Ogg Vorbis
is a compressed audio format similar to MP3, but free of patents and licensing fees. A normal
quality Ogg Vorbis file is encoded with a quality setting of "5". Note that unlike MP3
encoding, Ogg Vorbis does not let you set a bitrate, because some audio clips are easier to
compress than others. Increasing the quality will always increase the file size, however.
• MP3 Export Setup: Use these controls to locate your MP3 encoder and set the quality of
MP3 encoding. Higher quality files take up more space, so you will need to find the level of
quality you feel is the best compromise. For more information, see Exporting MP3 Files.

Spectrograms
You can view any audio track as a Spectrogram instead of a Waveform by selecting one of the
Spectral views from the track's pop−up menu. This dialog lets you adjust some of the settings for
these spectrograms.
• FFT Size: The size of the Fast Fourier Transform (FFT) affects how much vertical
(frequency) detail you see. Larger FFT sizes give you more low frequency resolution and less
temporal resolution, and they are slower.
• Grayscale: Select this for gray spectrograms instead of colored ones.
• Maximum Frequency: Set this value anywhere from a couple of hundred hertz to half the
sample rate (i.e. 22050 Hz if the sample rate is 44100 Hz). For some applications, such as
speech recognition or pitch extraction, very high frequencies are not important (visually), so
this allows you to hide these and only focus on the ones you care about.

Directories
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Use this panel to set the location of Audacity's temporary directory. Audacity uses this directory
whenever you work on a project that you haven't saved as an Audacity Project (AUP file) yet. You
have to restart Audacity (close and open it again) for changes to the temporary directory to take
effect.
This directory can contain a lot of files and is used a lot, so choose a disk with plenty of free space to
put it on. Never put it on a network drive.

Interface
• Autoscroll while playing
page flips to the right when the cursor travels to the right hand end of the wave display, either
during playback or recording. Always keeps the cursor on screen, but may cause breaks in
recording or playback if you have a slow machine.
• Always Allow Pausing
• Update spectrogram while playing
Tries to keep the spectrogram updated while playing. This requires a lot of cpu power, and
really isn't a good idea unless you're playing a really small piece or have a powerful CPU and
plenty of RAM. In combination with Autoscroll while playing this can cause pauses during
playback or recording.
• Enable Edit Toolbar
Gives you a toolbar of a few useful functions. Check out the page on the Edit Toolbar for
more information.
• Enable Mixer Toolbar
Turns on display of the Mixer Toolbar used to control soundcard mixer settings.
• Enable Mixer Toolbar
Turns on display of the Meter Toolbar, with VU meters you can use to monitor the recording
and playback levels of your project.
• Quit Audacity upon closing last window
Sets Audacity to shut down when the last project window you are working is closed. If you
turn this off then audacity will keep re−spawning new blank project windows until you do
File > Quit.
• Enable dragging left and right selection edges
Lets you manipulate selections by clicking on the edges and dragging them along the
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timeline.
• Enable dragging left and right selection edges
Sets the transport control button order as:Pause, Play, Stop, Home, End, Record. Rather than:
Home, Play, Record, Pause, Stop, End.
• Language
Lets you change the language of the menus and other onscreen text to the language of your
choice. Simply choose the correct option from the drop−down list. Note that for languages
with unusual character sets you need the correct fonts installed. If your menus come up all
???? that's what's wrong.
• Minimum of dB mode display range
This sets up the scale used for logarithmic waveform displays. Because Decibels are
logarithmic, it is impossible to have a 0 point on the scale, so some very quiet sounds will
display as silence. If you you reduce this effect by increasing the range, then the louder part
of the scale gets squashed, so there is a choice of settings for different uses. −48dB is a good
compromise for general work.

Keyboard
• Commands/Key Combination List
All commands in Audacity that can be triggered by a keyboard shortcut are listed here. Click
on the shortcut and the assigned keystroke is highlighted in the command/shortcut list. Click
on the "Clear" button to erase the keystroke assigned to the function selected in the
Commands column.
• Adding new shortcuts/changing shortcuts
Click on the command in the list. Click in to the field next to the "Set" button and press any
key or combination of command key(Shift,CTRL,ALT) and alphanumeric key(everything
else). The description of that key or key combo will appear in the field or replace the existing
keystroke. By clicking on the "Set" button, you can add or change this key or key combo as a
shortcut to the function selected in the Commands list.
• Saving your setup You can export your keyboard shortcut settings for safekeeping or to
import into audacity on another machine. Use Save... to save you settings to a file, Load... to
load a saved settings file, and Defaults to restore the default audacity settings.
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Head over to this page for step−by−step description of the dialog and how to edit the
command/keyboard combination list with a text editor.

Back to the main page

Back to the Reference page
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File Formats
Audacity Project format (AUP)

Sun Au / NeXT

Audacity projects are stored in an AUP file,
which is a format that has been highly optimized
for Audacity so that it can open and save projects
extremely quickly. In order to achieve this speed,
Audacity breaks larger audio files into several
smaller pieces and stores these pieces in a
directory with a similar name as the project. For
example, if you name a project "chanson", then
Audacity will create a project file called
chanson.aup which stores the general
information about your project, and it will store
your audio in several files inside a directory
called chanson_data. The Audacity Project
format is not compatible with any other audio
programs, so when you are finished working on a
project and you want to be able to edit the audio
in another program, select Export.

This is the default audio format on Sun and
NeXT computers, and it is usually u−law
compressed so not very high quality. U−law
compression is a very simple, fast but low quality
way to reduce the size of the audio by about 50%.
It is widely used in American telephone systems.
This format was one of the first audio formats
supported by Web browsers, and it is still often
used for short sound effects where quality is not
as important. Audacity can read this format, and
write files either in 8−bit u−law compressed or
16−bit uncompressed variants.

WAV (Windows Wave format)

IRCAM (Institut de Recherce et Coordination
Acoustique/Musique)
This is a very general file format that is
commonly used by computer music researchers.
Audacity can read this format.

This is the default uncompressed audio format on
MP3 (MPEG I, layer 3)
Windows, and is supported on almost all
computer systems. It can also be lightly
compressed (about 4:1) using the ADPCM codec, This is a compressed audio format that is a very
but this is less widely supported on non−windows popular way to store music. It can compress
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platforms. Audacity can read and write this
format, including ADPCM on all platforms.

AIFF (Audio Interchange File Format)

audio by a factor of 10:1 with little degradation in
quality. Audacity can both import and export this
format. For more information on how to export
MP3 files from within Audacity, see Exporting
MP3 Files.

This is the default uncompressed audio format on
Ogg Vorbis
the Macintosh, and it is supported by most
computer systems, but it is not quite as common
as the WAV format. Audacity can read and write This is a new compressed audio format that was
designed to be a free alternative to MP3 files.
this format.
Ogg Vorbis files are not as common, but they are
about the same size as MP3 with better quality
and no patent restrictions. Audacity can import
and export this format.

Back to the main page

Back to the Reference page
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Exporting MP3/OGG Files
Audacity has OGG export and import functionality built in. You can set the quality of the exported
OGG files in the preferences. OGG is vastly superior to MP3, especially at lower bitrates.
OGG should be preferred to MP3, except in situations in which MP3 is required. This can be the
case for external players, which do not support OGG.
Audacity cannot encode MP3 files by itself, because the MP3 encoding algorithm is patented and
cannot legally be used in free programs. However, Audacity has been programmed to recognize
other existing MP3 encoders that you can download separately. All you have to do is obtain the
appropriate MP3 encoder for your computer and then show Audacity where it is located.
If you use... You need to...
Windows

Download LAME and look for the file called lame_enc.dll. You can find binary
distribution on the net by Google searching for "lame compile download binary" or
visiting this list of mirrors.

Linux/Unix

Download LAME from it's home page and compile it as a shared object, then look
for the file called libmp3lame.so (usually in /usr/local/lib).

Macintosh

Download the appropriate LAMELib from here.

For links to these MP3 encoders, go to the Audacity web page (http://audacity.sourceforge.net)
and click on the link for your operating system.
The first time you try to export an MP3 file, Audacity will ask you to locate your MP3 encoder.
Locate the file indicated above. From then on, Audacity will not need to ask you again and you will
be able to export MP3 files easily!
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Support for more MP3 encoders may be coming in the future. Let us know if there is a particular
MP3 encoder you want supported.
What is an MP3 file and how does it differ from
WAV and AIFF files?

Why doesn't Audacity ship with an MP3
encoder?

MP3 (MPEG II, layer 3) is a popular format for
storing music and other audio. A typical MP3 file
is one tenth the size of the original WAV or AIFF
file, but it sounds very similar. MP3 encoders
make use of psychoacoustic models to, in effect,
"throw away" the parts of the sound that are very
hard to hear, while leaving the loudest and most
important parts alone.

Unfortunately, the algorithm to encode or create
MP3 files is patented, and Audacity would not be
able to include an MP3 exporting algorithm
without either charging a fee or violating the law
in many countries.

Unfortunately, no MP3 encoder is perfect, and so
an MP3 file will never sound quite as good as the
original. Still, most people find that the quality of
an MP3 file is virtually indistinguishable from a
CD when played on headphones or on small
computer speakers, which is why the format is so
popular.

Back to the main page

Back to the Reference page
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Toolbars
Main Toolbar

I/O Sliders and Input Selector

Edit Toolbar
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Main Toolbar Edit Toolbar Input/Output

Main Toolbar

Selection Tool
Cursor to Start
This is the main tool you use to select audio.
Click in a track to position the cursor, or click
and drag to select a range of audio. If you drag
from one track to another, you can select
multiple tracks. Extend a selection by
shift−clicking a new point in the track.
Playback will always begin at the position of the
selection cursor. If a range of audio is selected,
only the selected range will play.

Places the cursor at the start of the project.
SHIFT + click expands the selection to the start
of the project.

Play Button

Press the play button to listen to the audio in
your project. You can also hit the spacebar to
Envelope Tool
start or stop playback. Playback begins at the
current cursor position. If a region of audio is
selected, only the selected region will play. To
The envelope tool gives you detailed control
quickly play the entire project, execute Select
over how tracks fade in and out, right in the
All before playing. If there are multiple tracks
main track window. When the envelope tool is
selected, the amplitude envelope of each track is going to the same channel in your project, they
will be mixed automatically for playback.
highlighted in a green line, with control points
at the beginning and end of each track. To
change a control point, click it and drag it to a
new position. To add a new point, click
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anywhere in the track where there is not already
a control point. To remove a point, click on it
and drag it outside of the track until it
disappears, then release.

Time Shift Tool
This tool allows you to change the relative
positioning of tracks relative to one another in
time. To use this tool, simply click in a track
and drag it to the left or right. To align two
tracks together or reset their time shift back to
zero, use the Align Tracks Together or Align
with Zero commands.

Zoom Tool
This tool allows you to zoom in or out of a
specific part of the audio. To zoom in, click
anywhere in the audio. To zoom out, right−click
or shift−click. If you have a middle button, you
can middle−click to do the same thing as Zoom
Normal.
In addition, you can zoom into a region by
clicking and dragging the mouse to highlight the
region you want to see, then releasing the
mouse button.

Record Button

Press the record button to record a new track
from your computer's sound input device. Use
the Preferences to configure the recording
options. In particular, there is an option to
record stereo or mono, and there is an option to
play the other tracks while recording.
Recording always happens at the project's
sample rate.

Pause Button

Will pause during playback, or during
recording. Press again to unpause.

Stop Button

Press the stop button or hit the spacebar to stop
playback immediately.

Cursor to End
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Draw Tool
Enables the user to draw in to the actual
waveforms. This is especially useful to
eliminate small pops and clicks from material.
ALT + click smoothes a area of audio
CTRL + click & hold edits only one sample, no
matter whether you move the mouse left or
right.

Back to the main page

Places the cursor at the end of the project.
SHIFT + click expands the selection to the end
of the project.

Back to the Reference page
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Mixer Toolbar
Output

Input

Input Selector

These sliders control the mixer settings of the soundcard in your system.
The sliders will jump to zero (left most position) if the drivers do not expose these functions. This is
the case with some digital I/O cards from RME and possibly others as well. Generally most cards
that have a custom mixer application rather than the standard OS volume control won't work with
this function of audacity. On these cards you will not be able to control the anything with these
sliders, and you will need to set up the recording levels and the recording source using the card's
mixer program.
Output Slider

Input Slider

This is the left hand slider that lets you control
the output level of your soundcard. It actually
controls the output setting of the soundcard
driver.

This is the right hand slider that lets you control the
level of the input selected in the Input Selector. It
actually controls the recording level setting of the
soundcard driver.

Should your output sound distorted, this is not
the first place to look. You might get lucky
though, so give it a quick slide. Usually
however, the distortion comes from the mix of
your project clipping. You actually need to
reduce the level of your tracks. It is suggested
you reduce every track by the same amount.

What you record is also determined in the mixer
settings on your soundcard. There you can switch
certain sources on and off, such as the Line Input,
the Microphone Input or the CD Audio.
After selecting the corresponding input source with
the Input Selector, you can control the level of the
recording with this slider. Use the VU Meters on
the Meter Toolbar to get the correct recording level.
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Should your input sound distorted, you should
lower this slider until no distortion can be heard,
and the VU Meters do not hit the end of their travel.
Input Selector
Pick the input source you wish to
record from. All these items are
exposed by the soundcard driver, so the
this of options will vary with different
soundcards.
Back to the main page

Here is an example of an ESS
1969 soundcard with the Line In
input selected.

Back to the Reference page
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Edit Toolbar
All these tools perform the exact same function, as those accessible through the Edit menu, View
menu and keyboard shortcuts.

Cut
Removes the selected audio data and places it
on the clipboard. Only one "thing" can be on the
clipboard at a time, but it may contain multiple
tracks.

Undo
This will undo the last editing operation you
performed to your project. Audacity currently
supports full unlimited undo − meaning you can
undo every editing operation back to the last
time the document was saved.

Copy
Redo
Copies the selected audio data to the clipboard
without removing it from the project.
Paste
Inserts whatever is on the clipboard at the
position of the selection cursor in the project,
replacing whatever audio data is currently
selected, if any.

This will redo any editing operations that were
just undone. After you perform a new editing
operation, including simply resizing a track, you
can no longer redo the operations that were
undone.
Zoom In
Zoom Out

Trim
Zoom to Selection
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Deletes everything but the selection.

Zoom to entire Project

Silence
Erases the audio data currently selected,
replacing it with silence instead of removing it
completely.

Back to the main page

Back to the Reference page
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Tracks
Audio Tracks

Audio Track Controls

Label Tracks

Track Pop−Down Menu

Time Tracks

Solo Button

Note Tracks

Mute Button

Track Delete Button
Gain and Panning Controls
Vertical Track Resizing
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Audio Label Time Note

Audio Tracks
Audio tracks contain digitally
sampled sounds. In Audacity,
a channels of sound is
represented by one mono
audio track, a two channel
sound by one stereo audio
track. Each audio track has a
sample rate: common values
include 8000 (telephone),
16000 (speech), 22050 (many
games of recent years), 44100
(CD Audio), and 48000
(DAT).
From Audacity 1.2 on, you
can specify a different sample
rate for each track. You can
import audio of any sample
rate or bit depth and Audacity
will resample and convert it to
the project rate and bit depth
on the fly, as well as upon
Export. You can choose
different sample rate
conversion qualities for
playback and Exporting.
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(Note that in Audacity 1.0, all
tracks must be at the same
sample rate as the project.)
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Back to the Tracks page

104

Audacity Manual Title Page

Back to the main page

Back to the Tracks page
Audio Label Time Note

Label Tracks
Label Tracks can be used to annotate an audio
file. They can be used for lyrics, markers, or
notes, and they can even be used to save
selections.

To create a Label Track, select New Label
Track from the Project Menu. Alternatively,
simply click or select where you would like to
place a label, and choose Add Label at Selection
from the Project Menu, and a Label Track will
be created automatically if one doesn't already
exist.

To add a new label, click or select where you
want the new label to appear, then select Add
Label at Selection from the Project Menu, then
type the name of the label, and finally press
Enter or click outside of the label.

When editing the name of a label, you are
limited to using just the backspace key for
To edit the name of a label, click anywhere in editing. There is no way to move the insertion
it. Zoom in first if there are too many labels
point to append a letter to the beginning of a
crowded together and you are unable to click on label.
the one you want. When a label is selected for
editing, it looks like the first label below:
Once a label is selected, you can move to the
next label by pressing Tab, and move to the
previous label by pressing Shift−Tab.
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To delete a label or multiple labels, select the
area containing the label flags you wish to
delete, and choose Silence from the Edit Menu.
Alternatively you can delete an individual label
by clicking on it and pressing Backspace until
you have deleted all of the characters in the
label, then pressing Enter.
To move labels, use the normal editing
commands like Cut, Copy, Paste, Delete, and
Silence.

You can save a selection in a label. When you
create a new label, the left selection edge
determines the position of the label's flag.
However, the right selection edge is also stored
in the label, and when you click on it, the full
original selection will be restored.
If you wish to apply this selection to only a
subset of the tracks, shift−click in the label area
to the left of each track's waveform to change
whether each track is part of the selection or not.

Exporting and Importing label tracks
Label Tracks are saved when you save an
Audacity Project, so if you just want to continue and also provides a way to mass−edit the labels
using the labels along with the same file, just
if necessary.
save a project. But you can also export the labels
to a simple text file, and import them.
To export a Label Track, choose Export Labels...
from the File Menu. The exported file will
This allows you to save information about the
contain one line per label, starting with the time
locations of events in an audio file for use in
offset in seconds, then a tab, and then the name
another program,
of the label, for example :

1.217995
3.921073
7.584454

Bass intro
Guitar enters
Drums enter
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11.070002

Chorus

To import a Label Track, choose Import Labels... from the File Menu.

Back to the main page

Back to the Tracks page
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Note Tracks
Note tracks display data loaded from a MIDI file.
They are currently not editable or playable.
It's best to ignore the note tracks for now until further notice.

Back to the main page
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Time Tracks
This track consists of a single envelope.
It controls the playback speed within a
given range, i.e. it facilitates
envelope−based resampling. The
envelope handing is exactly the same as
for the volume envelope.
Clicking on the track panel reveals a few
options, similar to the ones of the track
panel of an audio track.
"Set Range" lets you set the minimum and
maximum pitch change. It is expressed in
percentage values relative to 100%.
Start by choosing New Time Track from
the Project Menu. Then change the range
of time warping by clicking on the Track
Pop−Down Menu and choosing Set Range
(an option which only appears for Time
Tracks)
The converter used will be the one(s) set
up on the Quality tab of the Preferences.
You can make separate choices for

To edit the time warping, choose the envelope tool
from the Control Toolbar − the same tool you use to
edit amplitude envelopes in Audio Tracks. Click to
create and edit control points. Drag points off the track
to delete them.
The Time Track has a ruler. As you edit the
warping, the ruler will warp to show you at what time
playback will reach each place in the audio.
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Realtime (playback) and High Quality
(exporting), trading speed against quality.
Older computers may be incapable of
playing audio in real−time that makes use
of a Time Track, however you can always
Export the file as a WAV and then
playback the WAV file later.

Back to the main page

Back to the Tracks page
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Back to the main page
Back to the Track page
Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Track Delete Button
Clicking on this button deletes

the track. This action is undoable.

Back to the Track page
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Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Vertical Track Resizing
For horizontal resizing, which is called zooming, visit the View Menu page.
Vertically resizing a track is fairly simple.
• Click and hold the mouse button on the
resizing handle (see figure),
• move mouse up or down until the track has
the wanted vertical size
• release mouse button

Note:
Stereo tracks have two resize handles. The one beneath the upper track lets you resize
both tracks in relation to one another.
The resize handle beneath the lower track resizes both tracks equally the same way. It
changes the overall vertical size of the whole stereo track.
Back to the Track page
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Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Pop−Down Menu
Name Edit the name of the track
Move Track Up/Down Move Track Up or Down in the display
Waveform Traditional display of audio material. It displays
the amplitude of the audio over time. This is the
default display mode.
Waveform (dB) Like Waveform, but logarithmic instead of linear
vertical units . It displays the amplitude in dB of
the audio over time.
Spectrum Displays the frequency spectrum of the audio over
time.
Pitch (EAC) Tries to detect the pitch of the current audio and
displays that information over time.
Mono Set playback of this single channel track on the
left and right channels.
Left Channel Set playback of this single channel track on the
left channel.
Right Channel Set playback of single channel track on the right
channel.
Make Stereo Track The selected track and that beneath it is turned in
to one stereo track.
Split Stereo Track Turn one stereo track in to two single channel
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tracks.
Set Sample Format Pick the sample format for this track. The result is
that all newly written data is written in this
format, no matter what format the original
material was in. Newly written data can be
produced by effects and generator plugins for
example.
Set Rate Set the sample rate of this track. Upon import, the
track sample rate is set to that of the imported
material. On playback or exporting the audio will
be re−sampled to the project rate on the fly. This
option can be useful to change the speed and pitch
of audio, or if the sample rate of the source was
wrong.
Back to the Stuff On Screen page
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Back to the main page
Back to the Track page
Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Track Solo Button
Clicking on this button will switch this track to solo mode. This action is not
reversible with the Undo function, but you can un−solo a track simply by clicking
it again.
In solo mode, only tracks that have the solo button activated (turning the button
red), will be played.
To deactivate the solo mode for that track, click on the button again. (button turns
grey again)
The state of the solo buttons is NOT saved in the project file, and it does not affect
Exporting or Mixing.
Back to the Track page
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Back to the main page
Back to the Track page
Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Track Mute Button
Clicking on this button will mute this track , i.e. this track is switched off without
deleting it. This action is not reversible with the Undo function, however you can
un−mute a track just by clicking the mute button again.
Muted tracks are easy to spot, because their Mute buttons are green.
To unmute the track, click on the button again. (button turns grey again)
The state of the mute buttons is NOT saved in the project file, and it does not
affect mixing (i.e. muted tracks are still mixed when you export or Quick Mix).
Back to the Track page
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Back to the main page
Back to the Track page
Delete Pop−Down Menu Solo Mute Gain and Panning Controls Vertical Track Resizing

Gain and Panning Controls
Gain (Volume)
This slider controls the track volume, or rather the overall gain of that
particular track.
It's default position is in the middle, as shown in the picture to the left. This
setting represents 0 dB.
Tip:

Normally the control moves in increments of 3
dB.
Hold down Shift to adjust by 1 dB at a time.

Pan
This slider set the panning position of the track in the stereo field.
It's default position is in the middle, as shown in the picture to the left.
Back to the Track page
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Back to the Reference page

Keyboard Shortcuts
!!Apple MacOS X users!! CTRL = Command

File Commands

Navigation, Playback & Recording

New Project

CTRL+N

Play/Stop

SPACE

Open Project

CTRL+O

Loop

SHIFT+SPACE

Close Project

CTRL+W

Save Project

CTRL+S

Pause

P

Preferences

CTRL+P

Record

R

Preview 1 second

1

Play From Cursor To
Selection

B

Zoom In

CTRL+1

Zoom Normal

CTRL+2

Zoom Out

CTRL+3

Fit In Window

CTRL+F

Editing Tools
Selection Tool

F1

Envelope Tool

F2

Editing Tool

F3

Zoom Tool

F4

Timeshift Tool
Multi Tool
cycle tool forward

L

F5
F6
D
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cycle tool backward

A

Edit Commands

Fit Vertically

CTRL+SHIFT+F

Zoom to Selection

CTRL+E

Undo

CTRL+Z

Redo (Windows)

CTRL+Y

Import Audio

CTRL+I

Redo (Mac/Unix)

CTRL+SHIFT+Z

Create Label

CTRL+B

Cut

CTRL+X

Copy

CTRL+C

Repeat Last Effect

CTRL+R

Paste

CTRL+V

Delete

CTRL+K
DELETE

Silence

CTRL+L

Duplicate

CTRL+D

Select All

CTRL+A

Find Zero Crossings

Z

Back to the main page

Back to the Reference page
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Back to the Reference page

Edit or Create
Keyboard Shortcuts
Where ?
In the preferences dialog, go to the keyboard section or edit the keyboard configuration file directly
with a text editor. You will find this file in the directory where you installed Audacity. Its filename
is Audacity−keys.xml .
Audacity will NOT load this keymap upon startup, but save them in the registry(Windows). Should
you make changes to the Audacity.xml file with a text editor, you'll need to load that shortcut file
with the "Load" button to make Audacity use them. Thus you can save your keymaps under any
filename with an XML extension and keep different keymaps around for different purposes.
Audacity will NOT store the current keymap in the file Audacity.xml. Should you want to make
changes to the current keymap with a text editor, you'll have to use the "Save" button to save that
keymap to an XML file first. After editing it you'll have to "Load" it again.
Editing and Creating Shortcuts with the Preferences Dialog

Changing a
shortcut:
1. Click on the
command in
the list. The
command to
be changed
is now
highlighted.
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2. Click in to
the box to
left of the
Set button. If
a shortcut
was assigned
to the
command
previously, it
will be
displayed in
this box.
3. Hit the key
or key
combination
you wish to
assign to this
command.
Then
processed to
the next step.
4. Click on the
Set button to
assign the
chosen key
or key
combination
to the chosen
command.

Clearing a
shortcut:
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1. Click on the
command in
the list. The
command to
be cleared is
now
highlighted.
2. Click on the
clear button
to clear the
command.
Editing and Creating Shortcuts with a text editor
The keyboard shortcuts you were editing with the dialog are stored in a simple XML file. Thus, you
can edit it with any text editor.
Each keyboard map starts with

<audacitykeyboard audacityversion="1.2">
and ends with

</audacitykeyboard>
Each command is defined with the command tag. An example :

<command name="Undo" label="Undo" key="Ctrl+Z" />.
name
The actual command as Audacity understands it.
label
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Command description as seen in the Preferences keyboard map editor.
key
This is the actual shortcut. Check out what the format is in the Preferences dialog.

Back to the main page

Back to the Reference page
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Back to the main page

Back to the Effects page

How do effects work in Audacity ?
1. Select some audio
Use the mouse or keyboard shortcuts to select some audio. You can listen to that selection as many
times as you like and adjust the boundaries of the selection.
2. Select an effect
You can pick any of the internal effects or a LADSPA or Nyquist plugin loaded by audacity.
Windows & Mac users can also use VST plugins via the VST Enabler from
www.audacityteam.org/vst/.
3. Tweak the parameters to your liking
Play around, go wild, honk your horn. Make those tough decisions without telling anyone why.
4. Let the software work
Hit the OK button. Or hit the Cancel button if you're unsure about something, like what time you
were supposed to take the pizza out of the oven.
5. Not happy ? UNDO
That effect didn't cut it ? Did that delay show up too late and you wondered where the summer went
? No problem.
Hit UNDO in the Edit menu (or press CTRL+Z).
Then go back to 3. In fact you can hit undo so many times, YOU might disappear. Or perhaps just all
your edits. Who knows.
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Back to the Effects page

Basic Calculus
of
Acoustics
This is so terribly useful for so many things. You can use this stuff to calculate just how bad parallel
walls are for sound, because of Standing Waves. What's that ? Coming attractions include exciting
info on how to improve the acoustics of your room and what standing waves, bass traps and
reflecting will do for your listening karma.
You may enjoy finding out that a $1000 subwoofer won't work in a small 3x3 meter room, 'cause the
big energy bass action will happen beyond your walls. After all, the first energy peak happens at 1/4
of wavelength. Check it for yourself and get smart the next time you buy those 'gotta get buried
with/under/in them' speakers.
This all happens in plain fresh air:
The speed of sound is 343 meters per second at 20 degrees Celsius
+/− 0.6 m/s for every degree Celsius more/less ( −> 340 m/s at 15 degrees Celcius)
c
speed of sound

=
=

lambda
wave length

*
f
* frequency

x

=

(1000 / c )

*

time [milliseconds]

=

time[ms] for one meter

*

y
distance
[meters]

Examples (at 20 degrees Celsius > c = 343 m/s):
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distance [meters]

time
[milliseconds]

0.34

1

3.43

10

6

18

10

29

50

188
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Back to the Effects page

Reverb
What is Reverb ?
A Reverb simulates the component of sound that results from reflections from surrounding walls or
objects. It is in effect a room simulator. Some people think it's just a delay effect with some filters,
but it's way more complex than that. Reverb effects (software plugins or external hardware units)
provide an interface to their changeable parameters that need some explaining. Let's look at a simple
room first.
Basic Simulation of a Room
Our model is a simple room with four straight walls, a sound source and a listener. In Figure 1 the
arrows stand for the path of traveling sound.
The listener hears the DIRECT signal first. The DIRECT signal is also referred to as the DRY part of
the signal when using any effect. Most digital reverbs produce two parts: The Early Reflections and
the Reverb component.

I. Early Reflections
The first Early Reflection reaches the listener
milliseconds after the direct signal does.
The path of the Early Reflections is longer. The
difference in time between the arrival of the
direct signal and the first Early Reflections is
measured in milliseconds.
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Figure 1
II. Reverb
The sound reflects off the walls and objects in
the room, and in time individual reflections
disappear and the Reverb develops.
Predelay
The time between the reception of the DIRECT
signal by the listener and start of the Reverb
portion of the effect is called Predelay. This is
a parameter in many digital reverb effects, and
it is expressed in milliseconds (ms).
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Reverb Time
The time difference between switching off any
sound generator and the level of the reverb
resulting from that sound dropping by 60dB is
called RT60.
This is usually referred to as the Reverb Time.
When anyone refers to the reverb time of a real
room or that of a digital reverb, RT60 is what
they're talking about.
Most digital reverbs feature this as a parameter.

Figure 1
Common parameters of a digital Reverb
Early Reflections Usually controlled via Room type and/or Room Size parameters.
The EARLY REFLECTIONS enable the human brain to quickly
identify the room size. They are therefore the most critical part of a
reverb effect, if a room simulation is the goal.

Predelay Parameter Range : 0 to x milliseconds
Time between Direct Signal and start of Reverb portion.
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The more space between you and walls or other reflective objects, the
greater the Predelay.

Reverb Time Parameter Range : 0.1 to x.x seconds
The greater the enclosed(!) volume of the space you're in, the longer
the reverb time. This is of course true only to a certain extent. The
larger the room or chamber, the louder your source signal needs to be
to produce any significant level of reverb tail. A good way to
demonstrate this is to visit some huge cathedral and talk quietly. Then
yell a bit and you'll actually hear some significantly loud reverb. The
RT60 value is measured with a noise impulse, but the level at which
that impulse was sent out should be known too.
Many reverb effects let you set different reverb times for different
frequency bands. Most reverb units on PC and Mac architectures
provide two bands, so you get to set the reverb time for each frequency
band individually.

Reverb Damping Usually a Highshelf and/or a Lowshelf EQ with variable Frequency.
These EQs are applied continuously to an evolving reverb of a piece of
audio. Over time, as the reverb fades, so do certain frequencies, either
in the lower or higher frequency range. The more less−reflective
surfaces the sound bounces around from, the more the reverb is
dampened the higher frequencies.
Freeverb features a Damping parameter that dampens the upper
frequencies.
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Reverb EQ Usually a Highshelf and/or Lowshelf EQ with variable Frequency.
These EQs are only applied to the output of the reverb or perhaps even
just the reverb portion of the Reverb effect. Some reverbs have
Highshelf and Lowshelf EQs for the Early Reflections as well.
Freeverb has both a Hicut and Lowcut parameter.

Here's a screenshot taken from the reverb plugin Renaissance Reverberator by Waves.

reproduced with permission

Here we have the Highshelf and Lowshelf EQs for Damping(left) and for the final output(right). The
upper middle display depicts the Early Reflections placement and level, as well as the Reverb
portion start and fading. Above this display is the Reverb Type selector. This changes the placement
and level of the Early Reflections. The Size slider has influence on the Early Reflections as well.
Blank concrete will reflect sound quite well across the frequency spectrum. A large thick curtain or
padded walls will reflect sound poorly. A large club filled with people sounds completely different
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from an empty one. People, comfy chairs, curtains, carpets, beds and many more objects reflect only
part of the sound that hits them.
Back to the main page

Back to the Effects page
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Delay
What is a Delay ?
This effect uses a RAM buffer to store the audio for a certain amount of time, after which it outputs
this audio.
The RAM buffer will not always be just large enough to store the amount of audio set by the current
delay time, but will actually be considerably larger sometimes, because many delay effects allow for
their delay parameter to automated.

Multi−Tap Delays
This effect simply incorporates several discrete delay lines, each with its own delay time,
level(amplitude) and panning. The feedback parameter is usually shared by all delays in a multi−tap
delay. Some multi−tap delays feature a modulation section that modulates the delay times, which can
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be used to create chorus effects.

Common parameters of a digital Delay
Delay Time Parameter Range : 0.000 to xxx.xxx seconds
The upper boundary of this parameter(xxx.xxx) depends on the
amount of RAM in the hardware unit, or the amount of RAM
reserved by the software plugin. For software plugins, the
programmers or designers of the plugin set this upper boundary.
The delay software plugin Supertap by Waves for example comes
in two flavours on Protools TDM systems. One allows for delays
of up to two seconds, but another version accommodates delay
times of up to six seconds. This is due to the availability of RAM
on the DSP hardware of a TDM system. The native(−>CPU)
version of this plugin for Windows for example only allows for
delays of up to four seconds in length, but there are delay plugins
that allow for delays of several minutes.

Feedback Today's delay units and plugins will feature one of several different
types of feedback parameters :
a) Percentage Range : 0 to 99(or 100)%
This is used by most hardware units and some software plugins. It
determines the amount of a delayed signal to be sent back to the
RAM buffer. The same delay time is applied. This is the most
common parameter type for feedback.
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b) Decay Time : 0.1 to xx seconds
A slightly different approach. The plugin or hardware unit
determines the amount of delayed signal, that it sends back in to its
RAM buffer, itself. Some may find this more intuitive. It isn't
widely used however.
c) Feedback Delay Time : 0.000 to xxx.xxx seconds
This is like an additional delay line that takes the already delayed
signal as input. This kind of parameter also requires a level setting,
which is usually a percentage parameter, like a).

EQs & Filters Many delay plugins feature highshelf and/or lowshelf EQs, or they
feature highpass and/or lowpass filters. These EQs or filters
usually process each delay. The idea behind this is usually to
simulate distance, because with increasing distance, the lower and
higher frequencies are dampened.
Hi− & Lowshelf EQs

Low− & Highpass Filters

• Gain : −xx to xx
dB
• Frequency: 20 Hz
− 20 kHz

• Frequency: 20 Hz − 20 kHz
• Filter Strength : 6, 12, 18 or
24 dB/Octave

PANNING These are the most common types of stereo panning parameters
you'll find.
LEFT RIGHT
−63

+64

LEFT RIGHT
0%

100%

LEFT RIGHT
−100% 100%
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Simply a panning control for the delay. The feedback parameter
may also have its own panning control.
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Chorus
What is a Chorus ?
A chorus is a Delay for which the delay time is modulated by an LFO ( Low Frequency Oscillator).
The most used LFO waveforms are sine and triangle.
Most modern chorus effect unit, be they plugins or hardware based, also spread the effect signal
across the stereo field. Sometimes a parameter to control the depth and other behaviours may be
encountered.
The effect can produce interesting sounds, one of which is to produce the illusion of more than one
instance of the instrument/vocalist being present. What you get out of this effect, largely depends on
your desire to experiment.
Play with the parameters one at a time and experiment.

Common parameters of a Chorus
Delay Time Parameter Range : 0.0 to xxx.xx milliseconds
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This is your normal delay parameter.

Modulation Range Parameter Range : 0−100% or sometimes in milliseconds
This determines the maximum amount of modulation applied to the delay time.

Modulation Rate Parameter Range : 0 − 20 Hz (frequency)
Also sometimes referred to as the LFO frequency. Higher frequencies produce
extreme effects.
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Compressor
Uncompressed:
A simple sine wave that drops off
by 6 dB at half time, to
demonstrate how some
compressors handle signals.

After:
The attack part of where the
compressor is working is clearly
visible at the start of the audio.
The release part still affects some
audio that is beneath the threshold
as the compressors gain change
slowly ebbs out and the material
fades back to normal level.
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Processors and Effects
A Reverb usually gives you the choice of how
much effects signal(also called WET part) and
how much of the original signal(also called DRY
part) you'd like to the plugin to output.

Not only do they output 100% WET signal, but
nobody usually mixes the unprocessed signals
with the processed either. They do so with
Reverb and Delay signals.

A processor doesn't have this option by nature.
The Equalizer and the Compressor are
processors. To mix the original signal and the
processed signal doesn't make sense for these
processors. Their output is always 100% WET.

Processors are usually placed in an INSERT,
which means they sit in the channel. The EQs on
your stereo or soundcard mixer work like this.
The signal passes through them.
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Frequently Asked Questions
I. General
1. Is Audacity really free? Why?
2. Who developed Audacity?
3. How can I help to improve Audacity?
4. I found a bug! Now what?
5. Can I include or sell Audacity on a
CDROM ?

II. Installation
1. Windows: What do I do with the .exe file?
2. Windows: How do I uninstall Audacity?
3. Mac: What do I do with the .sit file?
4. Unix: Why do I get failed dependencies
when installing from the RPM?
5. Unix: Why do I get an error while loading
the shared library libwx_gtk.so?

III. Using Audacity
1. How do I mix two tracks together?
2. Can I remove the vocals from a recording?
3. When I try to record harmonies with myself, why are the two tracks out of
sync?
4. Why doesn't Audacity ship with an MP3 encoder?

General

Installation

1. Is Audacity really free? Why?

1. Windows: What do I do with the .exe file?

Yes, in almost all senses. Audacity is not only
From the browser, select the option to "Run from curre
distributed free of charge, but you are also free to do This launches the Audacity setup program, which will
almost anything you want with it.
Audacity program files and create an entry in the start
Audacity is distributed under the terms of the General
Public License (GPL). You are free to use this
If you already downloaded the file, just double−click o
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program for personal or commercial purposes. You the installer.
are also free to give it away or sell it. The source
code to this program is freely available on the web, If you prefer not to use the Installer program, you can
Audacity as a ZIP file, which you can decompress usin
and you are free to modify it for your own use,
any other extraction program.
however any changes you make must also be
distributed under the GPL.
Audacity was build using wxWidgets, a software
2. Windows: How do I uninstall Audacity?
library which is released under the less−restrictive
LGPL. For more information, please visit
Audacity can be uninstalled by opening Add/Remove
http://www.wxwidgets.org.
The authors of Audacity decided to release it under the Control Panel. Select "Audacity" from the list and
button "Add/Remove". This launches the Audacity uni
the GPL for many reasons. Some of us do it out of
program.
generosity. Some of us do it for moral reasons,
because we feel that all software should be free,
while others of us believe that there is a need for both
3. Mac: What do I do with the .sit file?
free and commercial software in the world.
One reason Audacity is free is so that it will be more
You need a recent version of StuffIt Expander. StuffIt
popular. Many of us would rather see a million
comes with all Macintoshes and is usually configured
people happily using Audacity for free than have a
thousand people pay us. Most users are more friendly with all Mac web browsers. If Audacity does not deco
automatically, drag "audacity.sit" to StuffIt Expander t
when they get something for free.
Yet another reason is that it encourages collaboration. it.
If Audacity was shareware, it is unlikely that dozens
of people around the world would have contributed There is no need to install Audacity. Just drag the Aud
your Applications folder, or wherever else you would
code, bug fixes, documentation, and graphics.
To uninstall, just drag the entire folder to the trash.
2. Who Developed Audacity?
Audacity was started in the fall of 1999 by Dominic
Mazzoni while he was a graduate student at Carnegie
Mellon University in Pittsburgh, PA, USA. He was
working on a research project with his advisor,
Professor Roger Dannenberg, and they needed a tool

4. Unix: Why do I get failed dependencies when instal
RPM?

First, ensure that the wxGTK is installed; a link can be
our Linux page −
http://audacity.sourceforge.net/downl
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that would let them visualize audio analysis
algorithms. Over time, this program developed into a
general audio editor, and other people started helping
out.
Today, Audacity is developed using Sourceforge, an
online site that allows people around the world to
collaborate on free software projects. See
http://www.sourceforge.net for more
information. Dozens of people have contributed to
Audacity, and progress is continually accelerating.

Be sure that you use the appropriate version of wxGTK
1.2.x requires wxGTK 2.4.x, and it will not work with
version.

5. Unix: Why do I get an error while loading the share
libwx_gtk−2.4.so?
This could be one of two problems:
− If you installed the wxWidgets RPM, be sure to run
root) so your system knows about the new library.

− If you installed wxWidgets from source, it may have
installed in /usr/local, but /usr/local/lib may not be in y
path. Add /usr/local/lib to the file "/etc/ld.so.conf" and
There are many ways you can help. If you are a
programmer and you know C++, we can always use "ldconfig". You may also want to add "/usr/local/bin"
more developers. We especially need more Windows so that programs can find the "wx−config" utility.
and MacOS programmers, as many of the current
developers prefer Linux.
Using Audacity
If you are bilingual, you can help us translate
1. How do I mix two tracks together?
Audacity into another language.
3. How can I help to improve Audacity?

If you are good at writing, you can help us write
documentation and tutorials.
Finally, anyone can submit bug reports and
suggestions. The more detailed, the better.

Audacity mixes automatically. All you have to do is im
tracks into the same project, which you can do using th
Audio" command in the Project menu, or simply by dr
two audio files to Audacity. When you press the record
Audacity generates a new track automatically, also.

In order to save your mix, you can either Export the pr
If you would like to help out in any one of these
will automatically mix all of your tracks together, or y
ways, please email the developers at
audacity−devel@lists.sourceforge.net.your tracks and use the "Quick Mix" command in the P
You may also want to go to the Sourceforge web site
and join the mailing list yourself.
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4. I found a bug! Now what?

2. Can I remove the vocals from a recording?

With some stereo recordings, it is possible to remove t
because of the way in which the recording was mixed
Often, the vocals are placed in the exact center of the r
while all other instruments are slightly off−center. If y
the right channel from the left channel, the vocals get c
Be sure to let us know what operating system you run canceled out, leaving only the other instruments.
(such as Windows 98, MacOS 9.1, Fedora Linux 3,
etc.) and any other information about your computer This only works on some recordings!
that you think might be relevant.
To attempt this in Audacity, import a stereo recording,
the track pop−up menu (the little down−arrow next to
Then, can you reproduce the bug? If it happens
the track) and select "Split Stereo Track". Now select t
consistently, tell us the exact sequence of events
(the right channel) and use the "Invert" effect (from th
which causes the bug to occur. If you get an error
message, make sure you send us the exact text of the menu). Finally, use the track pop−up menus to make b
Mono channels, and then mix them together using Qui
error message.
you're lucky, the vocals will be gone.
We want to squash all of the bugs! Thanks for taking
the time to help us track them down.
3. When I try to record harmonies with myself, why ar
tracks out of sync?
5. Can I include or sell Audacity on a CDROM ?
This is normal and it happens because there is a small
when Audacity starts playing sound and when it actual
Basically the same as the first question, so that is a
big YES. You are also free to do almost anything you your speaker. Audacity does not automatically try to c
delay, and you must do it manually.
want with it. We do like to hear about it of course,
but as long as you comply with the GNU Public
To correct this delay, use the Time Shift tool to slide o
License, you'll be ok. This means that you need to
make any changes you make to Audacity available, tracks over until they line up. Note that you can use th
including the source code. The source code doesn't you are listening to the recording.
need to be on the CDROM, but it should be available
via the internet for example.
4. Why doesn't Audacity ship with an MP3 encoder?
The most important thing when reporting a bug is to
be as specific as possible. Give us enough
information that we can reproduce the bug ourselves,
otherwise it's unlikely that we'll be able to fix it.
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Unfortunately, the algorithm to encode or create MP3
patented, and Audacity would not be able to include a
exporting algorithm without either charging a fee or vi
law in many countries.

As a compromise, Audacity comes with the ability to u
encoders, which you must download separately. It is u
make sure you are in compliance with any licensing re
imposed by MP3 encoders.

For more information, see the page on Exporting MP3
Back to the main page
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GNU GENERAL PUBLIC LICENSE
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

02111−1307

USA

Preamble
The licenses for most software are designed to take away your
freedom to share and change it. By contrast, the GNU General Public
License is intended to guarantee your freedom to share and change free
software−−to make sure the software is free for all its users. This
General Public License applies to most of the Free Software
Foundation's software and to any other program whose authors commit to
using it. (Some other Free Software Foundation software is covered by
the GNU Library General Public License instead.) You can apply it to
your programs, too.
When we speak of free software, we are referring to freedom, not
price. Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
this service if you wish), that you receive source code or can get it
if you want it, that you can change the software or use pieces of it
in new free programs; and that you know you can do these things.
To protect your rights, we need to make restrictions that forbid
anyone to deny you these rights or to ask you to surrender the rights.
These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if you modify it.
For example, if you distribute copies of such a program, whether
gratis or for a fee, you must give the recipients all the rights that
you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their
rights.
We protect your rights with two steps: (1) copyright the software, and
(2) offer you this license which gives you legal permission to copy,
distribute and/or modify the software.
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Also, for each author's protection and ours, we want to make certain
that everyone understands that there is no warranty for this free
software. If the software is modified by someone else and passed on, we
want its recipients to know that what they have is not the original, so
that any problems introduced by others will not reflect on the original
authors' reputations.
Finally, any free program is threatened constantly by software
patents. We wish to avoid the danger that redistributors of a free
program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any
patent must be licensed for everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution and
modification follow.
GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains
a notice placed by the copyright holder saying it may be distributed
under the terms of this General Public License. The "Program", below,
refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law:
that is to say, a work containing the Program or a portion of it,
either verbatim or with modifications and/or translated into another
language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".
Activities other than copying, distribution and modification are not
covered by this License; they are outside its scope. The act of
running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the
Program (independent of having been made by running the Program).
Whether that is true depends on what the Program does.
1. You may copy and distribute verbatim copies of the Program's
source code as you receive it, in any medium, provided that you
conspicuously and appropriately publish on each copy an appropriate
copyright notice and disclaimer of warranty; keep intact all the
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notices that refer to this License and to the absence of any warranty;
and give any other recipients of the Program a copy of this License
along with the Program.
You may charge a fee for the physical act of transferring a copy, and
you may at your option offer warranty protection in exchange for a fee.
2. You may modify your copy or copies of the Program or any portion
of it, thus forming a work based on the Program, and copy and
distribute such modifications or work under the terms of Section 1
above, provided that you also meet all of these conditions:
a) You must cause the modified files to carry prominent notices
stating that you changed the files and the date of any change.
b) You must cause any work that
whole or in part contains or is
part thereof, to be licensed as
parties under the terms of this

you distribute or publish, that in
derived from the Program or any
a whole at no charge to all third
License.

c) If the modified program normally reads commands interactively
when run, you must cause it, when started running for such
interactive use in the most ordinary way, to print or display an
announcement including an appropriate copyright notice and a
notice that there is no warranty (or else, saying that you provide
a warranty) and that users may redistribute the program under
these conditions, and telling the user how to view a copy of this
License. (Exception: if the Program itself is interactive but
does not normally print such an announcement, your work based on
the Program is not required to print an announcement.)
These requirements apply to the modified work as a whole. If
identifiable sections of that work are not derived from the Program,
and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those
sections when you distribute them as separate works. But when you
distribute the same sections as part of a whole which is a work based
on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the
entire whole, and thus to each and every part regardless of who wrote it.
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Thus, it is not the intent of this section to claim rights or contest
your rights to work written entirely by you; rather, the intent is to
exercise the right to control the distribution of derivative or
collective works based on the Program.
In addition, mere aggregation of another work not based on the Program
with the Program (or with a work based on the Program) on a volume of
a storage or distribution medium does not bring the other work under
the scope of this License.
3. You may copy and distribute the Program (or a work based on it,
under Section 2) in object code or executable form under the terms of
Sections 1 and 2 above provided that you also do one of the following:
a) Accompany it with the complete corresponding machine−readable
source code, which must be distributed under the terms of Sections
1 and 2 above on a medium customarily used for software interchange; or,
b) Accompany it with a written offer, valid for at least three
years, to give any third party, for a charge no more than your
cost of physically performing source distribution, a complete
machine−readable copy of the corresponding source code, to be
distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer
to distribute corresponding source code. (This alternative is
allowed only for noncommercial distribution and only if you
received the program in object code or executable form with such
an offer, in accord with Subsection b above.)
The source code for a work means the preferred form of the work for
making modifications to it. For an executable work, complete source
code means all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to
control compilation and installation of the executable. However, as a
special exception, the source code distributed need not include
anything that is normally distributed (in either source or binary
form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component
itself accompanies the executable.
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If distribution of executable or object code is made by offering
access to copy from a designated place, then offering equivalent
access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not
compelled to copy the source along with the object code.
4. You may not copy, modify, sublicense, or distribute the Program
except as expressly provided under this License. Any attempt
otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under
this License will not have their licenses terminated so long as such
parties remain in full compliance.
5. You are not required to accept this License, since you have not
signed it. However, nothing else grants you permission to modify or
distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, by
modifying or distributing the Program (or any work based on the
Program), you indicate your acceptance of this License to do so, and
all its terms and conditions for copying, distributing or modifying
the Program or works based on it.
6. Each time you redistribute the Program (or any work based on the
Program), the recipient automatically receives a license from the
original licensor to copy, distribute or modify the Program subject to
these terms and conditions. You may not impose any further
restrictions on the recipients' exercise of the rights granted herein.
You are not responsible for enforcing compliance by third parties to
this License.
7. If, as a consequence of a court judgment or allegation of patent
infringement or for any other reason (not limited to patent issues),
conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License. If you cannot
distribute so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you
may not distribute the Program at all. For example, if a patent
license would not permit royalty−free redistribution of the Program by
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all those who receive copies directly or indirectly through you, then
the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under
any particular circumstance, the balance of the section is intended to
apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any
patents or other property right claims or to contest validity of any
such claims; this section has the sole purpose of protecting the
integrity of the free software distribution system, which is
implemented by public license practices. Many people have made
generous contributions to the wide range of software distributed
through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing
to distribute software through any other system and a licensee cannot
impose that choice.
This section is intended to make thoroughly clear what is believed to
be a consequence of the rest of this License.
8. If the distribution and/or use of the Program is restricted in
certain countries either by patents or by copyrighted interfaces, the
original copyright holder who places the Program under this License
may add an explicit geographical distribution limitation excluding
those countries, so that distribution is permitted only in or among
countries not thus excluded. In such case, this License incorporates
the limitation as if written in the body of this License.
9. The Free Software Foundation may publish revised and/or new versions
of the General Public License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.
Each version is given a distinguishing version number. If the Program
specifies a version number of this License which applies to it and "any
later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free
Software Foundation. If the Program does not specify a version number of
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this License, you may choose any version ever published by the Free Software
Foundation.
10. If you wish to incorporate parts of the Program into other free
programs whose distribution conditions are different, write to the author
to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes
make exceptions for this. Our decision will be guided by the two goals
of preserving the free status of all derivatives of our free software and
of promoting the sharing and reuse of software generally.
NO WARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING,
REPAIR OR CORRECTION.
12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES,
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.
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To do so, attach the following notices to the
to attach them to the start of each source file
convey the exclusion of warranty; and each file
the "copyright" line and a pointer to where the

program. It is safest
to most effectively
should have at least
full notice is found.

Copyright (C) 19yy
This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.
This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.
You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111−1307

USA

Also add information on how to contact you by electronic and paper mail.
If the program is interactive, make it output a short notice like this
when it starts in an interactive mode:
Gnomovision version 69, Copyright (C) 19yy name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'.
This is free software, and you are welcome to redistribute it
under certain conditions; type `show c' for details.
The hypothetical commands `show w' and `show c' should show the appropriate
parts of the General Public License. Of course, the commands you use may
be called something other than `show w' and `show c'; they could even be
mouse−clicks or menu items−−whatever suits your program.
You should also get your employer (if you work as a programmer) or your
school, if any, to sign a "copyright disclaimer" for the program, if
necessary. Here is a sample; alter the names:
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Yoyodyne, Inc., hereby disclaims all copyright interest in the program
`Gnomovision' (which makes passes at compilers) written by James Hacker.
, 1 April 1989
Ty Coon, President of Vice
This General Public License does not permit incorporating your program into
proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the
library. If this is what you want to do, use the GNU Library General
Public License instead of this License.
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